




Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Infor-
mation contained herein is for reference only and does not constitute a commitment on the part of the man-
ufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or
inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage
resulting from the use (or misuse) of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated,
transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer
or creators of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered
trademarks of their respective companies. They are mentioned for identification purposes only and are not
intended as an endorsement of that product or its manufacturer.

©October 2004

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain
U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights
owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and
is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Cor-
poration. Reverse engineering or disassembly is prohibited.
Intel® and Pentium® are US registered trademarks of Intel Corporation.
I



II

Preface
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifica-
tions not expressly approved by the manufacturer for compliance with the above standards could void your au-
thority to operate the equipment.



Preface
IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and
injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, 
in a wet basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. 
There may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They 

may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (DC Output 20V, 9A minimum).

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equip-
ment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, 
TELECOMMUNICATION LINE CORD
III
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be dam-
aged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating 
element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be 
badly damaged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the com-
puter in a humid environment.

Do not place the computer on 
any surface that will block the 
vents.
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t 
forget to save your work. Remember to periodically save your data as data may be lost if the battery is 
depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
V
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC adapter may be designed for international travel but it still requires a 

steady, uninterrupted power supply. If you are unsure of your local power specifi-
cations, consult your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The 
third prong is an important safety feature; do not defeat its purpose. If you do not 
have access to a compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, 
not by its wire.

• Make sure the socket and any extension cord(s) you use can support the total cur-
rent load of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external 
power supplies (i.e. AC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
I
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the com-

puter.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any 

way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, 
which may possibly result in fire.

• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative 

or qualified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. 

Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its
useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste
stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended
by the manufacturer. Discard used battery according to the manufacturer’s instructions.
VII
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and
the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer
from the power supply. Then refer servicing to qualified service personnel under any of the following con-
ditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s)
and screw(s) before turning the computer on.
III
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC adapter and cables. Stow them in the carrying bag. 
5. The AC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. How-

ever, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ 

adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for 

both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container).
Putting a notebook which is powered on in a travel bag may cause the vents/fan intakes to be blocked. To pre-
vent your computer from overheating make sure nothing blocks the vent/fan intake while the computer is in use.
IX
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshoot-
ing, keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is
very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful.
Avoid knocking the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the
computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your
computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to
turn it on). Note: Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in
flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead com-
partment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC adapter and keep your bat-
tery(ies) charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the
computer. Wait a few minutes before turning it on so that any moisture can evaporate.
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods
of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your
hands, wrists or other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly 
below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed 
position.

• Your knees should be slightly higher than your hips. Place your feet flat on the 
floor or on a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree 

angles when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Fre-

quent and short breaks are better than fewer and longer breaks.
XI
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your
neck and shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen 

clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.
II
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Quick Start Guide 1
Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 The Storage Devices (hard disk, optical device, 7-in-1 card reader, PC Card), Mail Program, 
Mouse & Printer.

• Chapter 3 The video and audio features of the computer.
• Chapter 4 The computer’s power saving options.
• Chapter 5 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 6 An outline of the computer’s built-in software. or BIOS (Basic Input Output System).
• Chapter 7 Instructions for upgrading your computer.
• Chapter 8 A quick guide to the computer’s TV Tuner, wireless, Bluetooth, camera and RAID modules 

(some of which may be optional depending on your purchase configuration).
• Chapter 9 A troubleshooting guide.
• Appendix A A definition of the interface, ports/jacks which allow your computer communicate with external 

devices.
• Appendix B The computer’s specification.
Overview 1 - 1
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 5 - 1, “BIOS Utilities” on page 6 - 1 and “Upgrading The Computer” on
page 7 - 1 in the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in the this Quick Start Guide should be enough to get you
up and running. Eventually you should try to look through all the documentation
(more detailed descriptions of the functions, setup and system controls are covered
in the remainder of the User’s Manual), but do not worry if you do not understand
everything the first time. Keep this manual nearby and refer to it to learn as you go.
You may find it useful to refer to the notes marked with a  as indicated in the mar-
gin. For a more detailed description of any of the interface ports and jacks see “In-
terface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the

 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Not Included
Operating Systems (e.g. Windows 2000 Professional, Windows XP etc.) and applications (e.g. word processing,
spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features. 
1 - 2 Overview
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find this manual refers to the following oper-
ating systems:

• Microsoft Windows 2000
• Microsoft Windows XP (Home & Professional Editions)

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 5 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed in Table 5 - 1, on page 5 - 7. You will be unable to use most advanced controls until the necessary drivers and util-
ities are properly installed. If your system hasn’t been properly configured (your service representative may have already
done that for you), refer to “What to Install” on page 5 - 1 for installation instructions.
Overview 1 - 3
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System Startup

1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the           

notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC adapter to the DC-In jack at the rear of the 

computer, then plug the AC power cord into an outlet, and connect 
the AC power cord to the AC adapter.

5. Move the LCD latches  in the direction of the arrows to     
release the top cover (the left latch will lock in position and is 
clearly marked with locked  and unlocked  icons).

6. Raise the lid/LCD to a comfortable viewing angle, and press the 
power button to turn the computer “on”.

7. Adjust the LCD panel to a comfortable viewing angle.
8. The LED indicators  show the power and battery status of the 

computer, and give notification of e-mail received.
Figure 1 - 1 - Top Panel with LCD Closed

1

2

Shutdown

Please note that you should always shut your computer down by choosing the Shut Down/Turn Off Computer command
from the Start menu in Windows. This will help prevent hard disk or system problems.

1. LCD Latches
2. LED Power & Communication 

Indicators

1 1

2

1 - 4 Overview
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System Map: Top View with LCD Panel Open

Figure 1 - 2 - Top View with LCD Panel Open

2

5

3

4

1

7

11

4
8

4 4 7 8

1. Optional Built-In PC 
Camera

2. LCD
3. LED Power & 

Communication 
Indicators

4. Speakers
5. LED Status Indicators
6. Built-In Microphone
7. Hot-Key Buttons
8. Power Button
9. Lid Sensor (not visible 

externally - see page 4 - 
8)

10. Keyboard
11. TouchPad and Buttons

Wireless Device Oper-
ation Aboard Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft. When
your computer ‘Boots
Up’ the modules will be
ON (see page 8 - 2).

The key combination Fn
+ F11 toggles power to
the WLAN module, Fn +
F12 to the Bluetooth
module.

9

6

10
System Map: Top View with LCD Panel Open 1 - 5
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LED Indicators
The two sets of LED indicators (LED Status Indica-
tors and LED Power & Communication Indicators)
on the computer display helpful information about the
current status of the computer.

Table 1 - 1 - LED Status Indicators

Table 1 - 2 - LED Power & Communication Indicators

Icon Color Description

Green Card Reader Activity

Green Hard Disk Activity

Green Number Lock Activated

Green Caps Lock Activated

Green Scroll Lock Activated (to 
activate press Fn & ScrLk)

Icon Color Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking Green The Computer is in 
Standby Mode

Orange The Battery is Charging

Green The Battery is Fully 
Charged

Blinking 
Orange

The Battery Has Reached 
Critically Low Power Status

Blinking Green New mail has arrived

Fast Blinking 
Green

New mail has arrived from 
users defined in the Special 
Group in Auto Mail Checker

Green The (optional) Wireless 
LAN Module is powered On

Orange The (optional) Bluetooth 
Module is powered On
1 - 6 System Map: Top View with LCD Panel Open
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Hot-Key Buttons
These keys access the internet, e-mail or a user-de-
fined application with one quick button press. Make
sure you install the driver to enable the Hot-Key func-
tions (refer to “What to Install” on page 5 - 1).

Table 1 - 3 - Hot-Key Buttons

The Hot-Key driver an icon  will appear in the task-
bar after the driver is installed. Right-Click the icon
and browse to Setup > Application 1, and an open di-
alog box will appear. Select an application (e.g. Mi-
crosoft Word) to open when you press the Application
Hot-Key (make sure you select the .exe file not a short-
cut to it).

Function Keys & Numeric Keypad
The keyboard has an embedded numerical keypad for
easy numeric data input (see Figure 1 - 3).

Activate the Number Lock feature by pressing the
Num Lk key at the top right of the keyboard. You may
check if Number Lock is enabled or not by looking at
the LED status indicators.Hot-Key Function

 Activate the Default E-mail Program

Activate the Default Internet Browser

Activate a User Specified Application 
(default is Windows Media Player) 

Other Keyboards

If your keyboard is damaged or you just want to make
a change, you can use any standard USB keyboard.
The system will detect and enable it automatically.
However special functions/hot-keys unique to the
system’s regular keyboard may not work.
System Map: Top View with LCD Panel Open 1 - 7
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Table 1 - 4 - Function Keys

Keys Description Figure 1 - 3 - Keyboard

Fn Function Key

Fn + F3 Mute Toggle

Fn + F4  Sleep Toggle

Fn + F5 Decrease Audio Volume

Fn + F6 Increase Audio Volume

Fn + F7 Display Toggle

Fn + F8 Decrease LCD Brightness

Fn + F9 Increase LCD Brightness

Fn + F11 WLAN Module Toggle

Fn + F12 Bluetooth Module Toggle

Fn + Scr 
Lk Scroll Lock Toggle

Fn Function Key

Numeric Keypad

Num Lk & Scr Lk Keys

Function Keys

Fn Key

Special Characters

Some software applications allow the number-keys to be used with Alt to
produce special characters. These special characters can only be produced
by using the numeric keypad. Regular number keys (in the upper row of the
keyboard) will not work. Make sure that Num Lk is on.
1 - 8 System Map: Top View with LCD Panel Open
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System Map: Front & Rear Views

1

2

1

4

Figure 1 - 4
Front & Rear Views

1. LCD Latches
2. Audio DJ Player 

Controls
3. Consumer Infrared 

Transceiver*
4. Vent/Fan Intake
5. DC-In Jack
6. Serial Port
7. Parallel Port
8. DVI-Out Port (for 

external display - 
see page 10 - 2) 

9. PS2 Port
10. RJ-11 Phone Jack
11. RJ-45 LAN Jack
12. CATV Jack*
13. S-Video-In Jack*

*Enabled with Optional
Mini-PCI TV Tuner Only

Overheating

To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while
the computer is in use.

2

4
6 7 8 95 11 12 13

Audio DJ Player

The built-in standalone audio CD player gives you direct hardware control for audio CDs (MP3
compatible) when the computer is shut down, but has a working power source.

3

10
System Map: Front & Rear Views 1 - 9
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System Map: Left View

Figure 1 - 5
Left View

1. S-Video-Out Jack
2. 4 * USB 2.0 Ports
3. 2 * Mini-IEEE 1394a 

Port
4. Line-In Jack
5. S/PDIF-Out Jack
6. Microphone-In Jack
7. Headphone-Out Jack
8. 7-in-1 Card Reader
9. PC Card Slot
10. Infrared Transceiver 

(see page 2 - 13)

3 31 5
2

4 6 7
8

10
9

Mini-IEEE 1394a

Both Mini-IEEE 1394a ports only support SELF POWERED IEEE 1394a devices.

7-in-1 Card Reader Formats

The card reader allows you to use the most popular digital storage card formats:

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS (Memory Stick Pro)
• SM (SmartMedia Card)
• CF (Compact Flash)
• IBM Microdrive

Note: If you are installing an operating system (e.g. Windows XP) you will need to disable
the card reader in the BIOS (see “Card Reader: (Advanced Menu)” on page 6 - 10).
1 - 10 System Map: Left View
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System Map: Right View 

Figure 1 - 6 - Right View

1. Primary Optical Device Drive 
Bay (for CD/DVD Device)

2. Secondary Optical Device 
Drive Bay (for CD/DVD 
Device)

3. Security Lock Slot

2
1

Changing DVD Regional Codes

Go to the Control Panel and double-click System >
Hardware (tab), click Device Manager, then click
the + next to DVD/CD-ROM drives. Double-click on
the DVD-ROM device to bring up the Properties di-
alogue box, and select the DVD Region (tab) to
bring up the control panel to allow you to adjust the
regional code (see “DVD Regional Codes” on
page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an
unexpected power interruption) you may push the end of a
straightened paper clip into the emergency eject hole. Do not use
a sharpened pencil or similar object that may break and become
lodged in the hole. 

Media Warning

Don’t try to remove a floppy disk/CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”.

3

System Map: Right View 1 - 11
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System Map: Bottom View 

Figure 1 - 7 - Bottom View

1. Battery
2. Vent/Fan Intake
3. Memory (RAM) Cover
4. Hard Disk Cover
5. Sub Woofer

2
1

2

2

4

2

3
CPU

The CPU is not a user
serviceable part.
Opening this compart-
ment, or accessing the
CPU in any way, may
violate your warranty.

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Use the computer with battery power until it
shuts down due to a low battery. When charging the battery, don’t stop until the LED charging indicator light changes from
orange to green. Completely discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 4 - 9 for full instructions.

5

1 - 12 System Map: Bottom View
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Windows XP Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of
the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu. The Control Panel allows you to configure the settings for most of the
key features in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic control panels for
many of the features, however many new control panels are added (or existing ones are enhanced) when you
install the drivers listed in Table 5 - 1, on page 5 - 7. 

Figure 1 - 8
Start Menu & Control Panel
Windows XP Start Menu & Control Panel 1 - 13
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Video Features
Video Driver Controls
You can switch display devices, and configure display options, from the Display Properties control panel in
Windows as long as the video driver is installed. For further video information see “Video & Audio Controls”
on page 3 - 1.

1. Click Start, point to Settings and click Control 
Panel (or just click Control Panel).

2. Double-click Display (icon) - In the Appearances 
and Themes category.

3. Click Settings (tab) in the Display Properties dialog 
box.

4. Move the slider to the preferred setting in Screen 
area/resolution .

5. Click the arrow, and scroll to the preferred setting In 
Colors/Color quality .

6. You can also access Display Properties by right-
clicking the desktop and scrolling down and clicking 
Properties. Click Settings (tab) and adjust as 
above.

7. Open the Display Properties control panel, and click 
Advanced (button)  to bring up the Advanced 
properties tabs. Clicking through these tabs allows 
you to make any video adjustments you require.

Figure 1 - 9 - Display Properties Desktop

1

2

3Right-Click
Desktop

21

3

1 - 14 Video Features
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Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or
TV as your display device. A VGA monitor/Flat Panel Display connects to the DVI-Out port, a TV to the S-
Video-Out jack.You have the following display modes available from nView Display Settings (tab) in the Ge-
Force 6800 Go Properties control panel tab (see  Chapter 3“Video & Audio Controls” from page 3 - 1 for fur-
ther details).

Table 1 - 5 - Display Options

Display Mode Description Win XP Win 2000

Single One of the connected displays is used as the display device

Clone Both connected displays output the same view

Dualview Both connected displays are treated as separate devices, and act 
as a virtual desktop X

Display Wizard

Use the Display Wizard in the Desktop Management window to quickly setup and configure any attached displays (see
Figure 3 - 4 on page 3 - 6).
Video Features 1 - 15
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Power Management Features
The Power Options control panel in Windows (see page 1 - 12) allows you to configure power management
features for your computer. You may conserve power through individual components such as the monitor or hard
disk (by means of Power Schemes), or you may use either Standby or Hibernate mode to conserve power
throughout the system (enable Hibernate support from the control panel as pictured in Figure 1 - 10). Pay at-
tention to the instructions on battery care in “Battery Information” on page 4 - 9.

Figure 1 - 10 - Power Options

The computer’s power button, sleep button (Fn + F4 key combination), and Lid Sensor may be set to send
the computer in to either Standby or Hibernate mode.

Power Saving and Performance
Power Schemes may have an affect on your computer performance (see “Power Schemes” on page 4 - 4). 
1 - 16 Power Management Features
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Chapter 2: Storage Devices, Mail Program, 
Mouse & Printer
Overview
Read this chapter to learn more about the following main features and compo-
nents of the computer:

• The Hard Disk Drive
• The Optical (CD/DVD) Device
• 7-in-1 Card Reader
• The PC Card Slot
• The Check Mail Program
• The TouchPad & Buttons/Mouse
• The Infrared Transceiver
• Adding a Printer (general guidelines)
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk
can be taken out to accommodate other 2.5" IDE hard disk drives with a height
of 9.5 mm.

The hard disk  is accessible from the bottom of your computer as seen be-
low. Further details on removing and inserting the hard disk are available in
“Upgrading the Hard Disk Drive(s)” on page 7 - 4.

Power Safety

Before attempting to
access any of the inter-
nal components of
your computer please
ensure that the ma-
chine is not connected
to the AC power, and
that the machine is
turned off. Also ensure
that all peripheral ca-
bles, including phone
lines, are disconnected
from the computer.

Figure 2 - 1
Hard Disk Location

1

Hard Disk

1

- 2 Hard Disk Drive
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Optical Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The ac-
tual device will depend on the model you purchased (see “Storage Options”
on page  B - 3). The optical device is usually labeled “Drive D:” and may be
used as a boot device if properly set in the BIOS (“Boot Menu” on page 6 -
13).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD
onto the disc tray with label-side facing up (use just enough force for the disc
to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock
“clicks” and you are ready to start. The busy indicator  will light up while
data is being accessed, or while an audio/video CD, or DVD, is playing. If
power is unexpectedly interrupted, insert an object such as a straightened pa-
per clip into the emergency eject hole  to open the tray.

Sound Volume 
Adjustment

How high the sound
volume can be set de-
pends on the setting of
the volume control
within Windows. Click
the Volume icon on
the taskbar to check
the setting. 

Peripherals must be
connected before you
turn on the system.

Figure 2 - 2
Optical Device

1

2

3

1
2 3

12

3

Optical Device 2 - 3
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 Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged.
Please follow the advice below to make sure that the data stored on your CDs/
DVDs can be accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency
eject hole. However
please do NOT use a
sharpened pencil or
similar object that may
break and become
lodged in the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it.
This may cause the
system to “crash”.
- 4 Optical Device
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DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 11.
.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, 

South Korea, The Philippines, 
Indonesia, Hong Kong

4
South & Central America, 

Mexico, Australia, 
New Zealand

5 N Korea, Russia, Eastern 
Europe, India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding

Figure 2 - 3
DVD Regions
Optical Device 2 - 5
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 7-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push
the card into the slot and it will appear as a removable device.

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS (Memory Stick Pro)
• SM (SmartMedia Card)
• CF (Compact Flash Types I & II)
• MD (IBM Microdrive)

The cards will appear as removable disks on the computer and can be accessed
in the same way as your hard disk (s).

Operating System 
Installation Warning

If you are installing an
operating system (e.g.
Windows XP), and
have a 7-in-1 Card
Reader present, make
sure to set the Card
Reader option in the
BIOS to “Disabled”.
See “Card Reader:
(Advanced Menu)”
on page 6 - 10.

Card Reader Cover

Make sure you keep the
cover in the card reader
when not is use. This will
help prevent foreign objects
and/or dust getting in to the
card reader.

Figure 2 - 4
Removable Disks
- 6 7-in-1 Card Reader



Storage Devices, Mail Program, Mouse & Printer

2
PC Card Slot
The computer is equipped with a PCMCIA 3.3V/5V slot for one type II PC
Card. Make sure you install the driver for the PC Card (see “What to Install”
on page 5 - 1).

Inserting and Removing PC Cards 
• Align the PC Card with the slot and push it in until it locks into place.
• To remove a PC Card, simply press the eject button  next to the slot.

Figure 2 - 5
PC Card Slot

1

1

PC Card Slot 2 - 7
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 Check Mail Program
After you have installed the driver for the Check Mail program (see “What
to Install” on page 5 - 1) you may then configure it to give notification
when new mail is received. You must be online to receive this notification
(note that this program only supports the POP3 protocol), and your default
mail program does not need to be open.

If you have installed the driver using the default settings, the CheckMail
program appears in the Startup menu (Start > Programs/All Programs
> Startup > CheckMail).

Figure 2 - 6
Check Mail Program 

(Startup Menu)
- 8 Check Mail Program
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Clicking on Check Mail will bring up the following options menu. 

You may then configure the options for your mail server, user name, and
password. Click Enable Check Mail to have the program check the mail
server for new mail, and set the interval (in seconds). Click SAVE to keep
the settings, and Hide to minimize the program. After clicking Hide, the
program will be accessible by double-clicking the icon  in the taskbar. If
you click the close icon  in the Check Mail control panel you will need
to run the program again from the Start menu in Windows.

Note

Check with your Inter-
net Service Provider,
network administrator
or Mail Service provid-
er for details on what to
put on these pages.

Figure 2 - 7
 Check Mail 

Account Setup 
and Options
Check Mail Program 2 - 9
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You may enable an audible warning for received mail by clicking on Set
Mail Wave, and browsing to a .WAV sound file to use for mail notifica-
tion. Click Enable play wave for mail arrival, and SAVE to save the set-
tings.

Figure 2 - 8
Check Mail Enabled

Figure 2 - 9
Set Mail Wave 
- 10 Check Mail Program
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TouchPad and Buttons/Mouse
The TouchPad is a device for pointing (controlling input positioning) on the
computer’s display screen by sensing finger movement, and downward pres-
sure. It is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports.

The TouchPad buttons function in much the same way as a two-button mouse.
The central button may be configured to function as you require (see Figure
2 - 10 on page 2 - 12 for screen examples).

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only ena-
ble its basic functions.
Be sure to check the
device’s user docu-
mentation for details.
TouchPad and Buttons/Mouse 2 - 11
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 Configuring the TouchPad and Buttons
Once you have installed the TouchPad drivers (see “What to Install” on
page 5 - 1) you can configure the functions by double-clicking the TouchPad
driver icon  on the taskbar. You may then configure the TouchPad tapping,
buttons, scrolling, pointer motion and sensitivity options to your preferences.
You will find further information on this at www.synaptics.com.

Figure 2 - 10
Mouse Properties
- 12 TouchPad and Buttons/Mouse
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Configuring the Infrared Settings for FIR
To configure your computer for Fast Infrared (FIR) communication follow
these steps:

1. Click Start, point to Settings and click Control Panel (or just click Start > 
Control Panel).

2. Double-click Wireless Link (Printers and Other Hardware Category) icon.
3. Click Hardware (tab), and click the Properties button, then click the 

Advanced (tab).
4. Select “Infrared Transceiver A” and change the Value to “HP HSDL-

2300/3600”.
5. Click OK > OK.
6. Restart the computer if prompted to do so.

For further information, please refer to the manual of the device you wish to
connect.

Infrared 
Communication

The infrared transceiv-
er operates on a “Line
of Sight”.

Make sure nothing is
blocking the “Line of
Sight” between your
system’s transceiver
and the destination’s
transceiver.
Configuring the Infrared Settings for FIR 2 - 13
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 Adding a Printer
The most commonly used peripheral is a printer. The following conventions
will help you to add a printer, however it is always best to refer to the printer
manual for specific instructions and configuration options.

USB Printer
Most new printers have a USB interface connection. You may use any one of
the ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/

ink cartridge etc.). 
2. Turn ON the computer.
3. Turn ON the printer. 
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or 

ask you to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the
sidebar.

Parallel Printer

After setting up the
printer attach the paral-
lel cable to the printer.

Connect the printer’s
parallel cable to the
Parallel port.

Turn ON the printer,
then the computer.

Windows will identify
the printer and either
load one of its own
drivers or ask you to
supply one. Follow the
on-screen instructions.
- 14 Adding a Printer
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Chapter 3: Video & Audio Controls
Overview
This chapter covers:

• Keyboard Video Controls
• NVIDIA Video Driver Controls
• Display Devices
• Attaching Other Displays
• Enabling TV Display
• Audio Features
• Audio DJ Player

Note: All operating system pictures in this manual are from the Microsoft
Windows XP OS.

Drivers

You are unable to use
most advanced con-
trols until the neces-
sary drivers and
utilities are properly in-
stalled. If your system
hasn’t been properly
configured (your ser-
vice representative
may have already
done that for you), re-
fer to “What to In-
stall” on page 5 - 1 for
installation instruc-
tions.

Protecting the LCD

Do not allow any foreign objects (i.e. paper or plastic) to get between the lid/LCD
and the work panel. They could damage or scratch the LCD and/or accidentally ac-
tivate the Lid Sensor.
Overview 3 - 1
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Keyboard Video Controls
This section is about making adjustments for the LCD, and switching display
devices. If you have any other display devices attached you can switch
through the display options with the Fn + Display (F7) toggle.

Opening the LCD
As you open the lid, adjust it so you can look at the screen straight on, without
any glare. If necessary, adjust the brightness controls (Fn + F8/F9).

Function Key 
Combination

You can use the FN +
F7 key combination to
toggle through the dis-
play options if you
have any external dis-
plays attached:

• Notebook Only
• External Display 

Only
• Notebook + External 

Display

Make sure you give the
displays enough time
to refresh.

Figure 3 - 1
Keyboard Video 

Controls

Fn

F9F8F7
- 2 Keyboard Video Controls
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NVIDIA Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features”
on page 1 - 14.

NVIDIA GeForce 6800 Go Properties
More advanced video configuration options are provided in the GeForce 6800
Go Properites control panel tab:
1. Open the Display Properties (see “Video Features” on page 1 - 14) con-

trol panel.
2. Click the Advanced (button).
3. Click GeForce 6800 Go (tab).
4. Clicking the Additional Properties options allows you to make any video

adjustments required.

NVIDIA Taskbar Icon

Click the NVIDIA icon
 in the taskbar to

bring up the trouble-
shooting menu, and go
to the GeForce 6800
Go Properties from
the menu (click NVID-
IA Display > Laptop
Display).

If you cannot see the
tray icon , go to the
GeForce 6800 Go
Properites control
panel tab and select
the Troubleshooting
item from the Addi-
tional Properties
menu. Click the tickbox
“Display the NVIDIA
Settings icon in the
taskbar”.

GeForce 6800 Go Properites from Desktop

To access the GeForce 6800 Go Properties from the desktop:

1. Right-click the desktop. 
2. Point to NVIDIA Display and click Laptop Display.
NVIDIA Video Driver Controls 3 - 3
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Additional Properties
The items listed in the Additional Properties window allow you to configure
your display(s). If the items do not display you can either click the Additional
Properties button, or click the icon .

Some screen examples are shown on the following page.

Screenshots

All screenshots in this
chapter are from the
Windows XP OS.

If you are using the
Windows 2000 OS
some screens in may
appear slightly differ-
ent.

Figure 3 - 2
Additional 
Properties

Click pin icon to push pin in
to keep the menu open.
- 4 NVIDIA Video Driver Controls
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You may make changes to the Display Settings, Color Correction, Video
Overlay, Resolutions, Refresh Rates and Screen Rotation by clicking the ap-
propriate tab and adjusting the setting.

Right-click on a control panel
item to bring up a Help menu 
(see sidebar).

Help Menus

Right-click on many of
the items in the tabs to
bring up the “What’s
This?” button.

Click the “What’s
This?” button to bring
up the help menu.

Figure 3 - 3
Screen Examples
NVIDIA Video Driver Controls 3 - 5
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NVIDIA nView Desktop Manager
The nView Desktop Manager allows quick access to control panels for fea-
tures such as Desktop Management, Profiles, Hot Keys etc. The Control panel
may be accessed as follows. 
1. Click Start, point to Settings and click Control Panel (or just click Control 

Panel).
2. Double-click NVIDIA nView Desktop Manager (icon) - Click "Switch to 

Classic View" from the left of the menu if you are in Category View.

Enable nView 
Desktop Manger 
from Additional 

Properties

You can view the
nView Desktop Man-
ager control panels
from the Additional
Properties window.

Select Additional
Properties from the
GeForce 6800 Go
Properites. Click the
Desktop Manage-
ment window and click
the Enable button to
display the options.

Figure 3 - 4
Desktop Manager

Control Panel

Right-click the Enable button
to display the Desktop Management
options menu.

The Display Wizard helps you to quickly 
configure any attached displays. 
- 6 NVIDIA Video Driver Controls
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Display Devices
Besides the built-in LCD, you can also use an external monitor/flat panel dis-
play or TV/HDTV as your display device. The following are the display op-
tions:

1. The built-in LCD.
2. An external monitor connected to the DVI-Out Port (may require DVI to VGA 

converter).
3. A flat panel display connected to the DVI-Out Port (may require DVI to VGA 

converter).
4. A TV/HDTV (HDTV requires an HDTV converter) connected to the S-Video-

Out jack.

Display Wizard

Use the Display Wiz-
ard in the Desktop
Management window
to quickly setup and
configure any attached
displays (see Figure 3
- 4 on page 3 - 6).

Monitor and TV Tuner

If you are connecting both a monitor/flat panel display to the DVI-Out 
Port, and a cable/aerial to the optional TV Tuner module, make sure you attach
the cable/aerial to the TV Tuner first, then the monitor.
Display Devices 3 - 7
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Attaching Other Displays
If you prefer to use a monitor or flat panel display, connect it to the DVI-Out
Port at the rear of the computer. You can use the Fn + F7 key combination to
toggle through the display options.
1. Attach your external monitor to the DVI-Out Port (or TV/HDTV to the S-

Video-Out jack), and turn it on.
2. Go to Additional Properties in the GeForce 6800 Go Properites control

panel tab (“NVIDIA GeForce 6800 Go Properties” on page 3 - 3).
3. Select nView Display Settings (available if external display is attached).
4. Select the display mode from the nView Display Mode drop box.
5. Select Apply.
6. Click Yes to confirm the settings.

Function Key 
Combination

You can use the FN +
F7 key combination to
toggle through the dis-
play options:

• Notebook Only
• External Display 

Only
• Notebook + External 

Display

Make sure you give the
displays enough time
to refresh.

Figure 3 - 5
nView Display 

Settings
- 8 Attaching Other Displays
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7. Select the display option from the Primary Display/ Secondary Display
dropbox. If you have a TV and external monitor/flat panel display attached
you will have a number of available options (see sidebar). Select and Apply
the appropriate option.

8. Click the monitor icon to select it, then click the Device Settings button to
make any adjustments for the selected display (including Screen
Resolutions & Refresh Rates).

9. Click Apply to confirm any setting changes.

nView Display Mode 
Options

The display options
listed under the Prima-
ry display: / Secondary
display: drop boxes will
differ according to the
displays attached, and
the Display Mode
chosen.

Figure 3 - 6
Primary/

Secondary Display 
Dropbox
Attaching Other Displays 3 - 9
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Display Modes
Single Display
Only one of your displays is used.

Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on
the other display(s). This mode will drive multiple displays with the same con-
tent and each display device can be configured independently.

Dualview
Dualview treats both connected displays as separate devices, and they act as a
virtual desktop resulting in a large workspace. When Dualview is enabled, you
can drag any icons or windows across to the other display desktop. It is there-
fore possible to have one program visible in one of the displays, and a different
program visible in the other display (Dualview is not available in Windows
2000).

Display Wizard

Use the Display Wiz-
ard in the Desktop
Management window
to quickly setup and
configure any attached
displays (see Figure 3
- 4 on page 3 - 6).
- 10 Attaching Other Displays
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Enabling TV Display
To display desktop images on a TV, connect the TV to your computer by using
an S-Video cable from the TV to the S-Video-Out jack on the left side of the
computer (see “System Map: Left View” on page 1 - 10). 

You will need to enable the TV display from the nView Display Settings tab
(see “Attaching Other Displays” on page 3 - 8). The TV will appear as a dis-
play option (select the display option from the Primary Display/ Secondary
Display dropbox) when attached to the S-Video-Out jack.

To get a full range of options from the Device Settings menu click the Detect
Displays button. Click to select the TV icon, then click the Device Settings
button. 

Figure 3 - 7
TV Settings

Clone Mode Dualview Mode 
Enabling TV Display 3 - 11
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Set the TV format from the Select TV Format menu. The Advanced option
(in Dualview mode) at the bottom of the Select TV Format menu allows you
to select TV format by country if you are unsure of your TV format.

Device Adjustments (Device Settings menu) allows you to make changes to
the TV output.

Figure 3 - 8
TV Settings and 

Adjustments
- 12 Enabling TV Display
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Audio Features
You can configure the audio options on your computer from the Sounds and
Audio Devices  /Sounds and Multimedia  Windows control panel (see
Figure 1 - 8 on page 1 - 13), or from the Sound Effect Manager  icon in
the taskbar/control panel (this will bring up the Realtek Audio Configuration
menus). The volume may also be adjusted by means of the Fn + F5/F6 key
combination.

Sound Volume 
Adjustment

How high the sound
volume can be set us-
ing the volume control
knob depends on the
setting of the volume
control within Win-
dows. Click the
Speaker icon on the
taskbar to check the
setting.

Figure 3 - 9
Realtek Audio 
Configuration 

Menus
Audio Features 3 - 13
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Audio “DJ” CD Player
The built-in standalone audio CD player gives you direct hardware control
for audio CDs/DVDs when the computer is shut down, but has a working
power source.

1. Make sure that the computer is shut down (i.e. the operating system 
is not running) but you have a working power source (either battery 
or AC Power).

2. Press the Audio DJ power button.
3. Press the open button on your CD/DVD device (or press the stop but-

ton  twice) and carefully place an audio CD onto the disc tray with 
label-side facing up (DVD drives will also play audio CDs).

4. Gently push the CD/DVD tray in until its lock “clicks” and you are 
ready to start. 

5. The Audio Format Indicator will flash while data is being accessed 
and will then display the audio format of the CD/DVD (CD or MP3).

6. The LCD will display the number of tracks.
7. Click the play/pause button to start the CD/DVD.
8. You can control the CD/DVD tracking and volume from the control 

panel.
9. Use the stop button to stop the disc, or press it twice to eject the disk.
10. The player can be turned off by pressing the power button again.

Disk Eject Warning

Don’t try to eject a CD/
DVD while the system
is accessing it. This
may cause the system
to “crash”. Stop the
disk first then eject it,
or press the stop but-
ton twice.

7

- 14 Audio “DJ” CD Player
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1. Audio DJ Power Button 
2. Previous Track
3. Next Track
4. Shuffle (loop, in order, shuffle)
5. LCD Display
6. Play/Pause
7. Stop (press twice to eject the CD/DVD)
8. Volume Down
9. Volume Up
10. Audio Format Indicator
11. Shuffle Mode Indicator
12. Track Indicator

3 9

101112 TV Tuner Option

If you have included
the optional TV Tuner
in your purchase con-
figuration, you can use
the supplied remote
control unit to control
the audio “DJ”.

Figure 3 - 10
Audio “DJ” 

Controls
Audio “DJ” CD Player 3 - 15
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Chapter 4: Power Management
Overview
To conserve power, especially when using the battery, your computer uses the
ACPI power management system. Power management conserves power by
controlling individual components of the computer (the monitor and hard disk
drive) or the whole system.

This chapter covers:

• The Power Sources
• Turning On the Computer
• Power Schemes
• System Power Options (Standby and Hibernate)
• Configuring the Power Button
• Battery Information

Advanced Configuration and Power Interface
The ACPI interface provides the computer with enhanced power saving tech-
niques and gives the operating system (OS) direct control over the power and
thermal states of devices and processors. For example, it enables the OS to set
devices into low-power states based on user settings and information from ap-
plications. ACPI is fully supported in Windows 2000 and Windows XP.

OS Note

Power management
functions will vary
slightly depending on
your operating system.
For more information it
is best to refer to the
user’s manual of your
operating system. 

(Note: All pictures
used on the following
pages are from the
Windows XP OS.)
Overview 4 - 1
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The Power Sources
The computer can be powered by either an AC adapter or a battery pack.

AC Adapter
Use only the AC adapter that comes with your computer. The wrong type of
AC adapter will damage the computer and its components.

1. Attach the AC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord 

to the AC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or
when an electrical outlet is unavailable. Battery life varies depending on the
applications and the configuration you're using. To increase battery life, let
the battery discharge completely before recharging (see “How do I com-
pletely discharge the battery?” on page 4 - 12).

We recommend that you do not remove the battery. For more information on
the battery, please refer to “Battery Information” on page 4 - 9.

Power Button as 
Standby or Hibernate 

Button

If you are using a fully
ACPI-compliant OS,
(such as Windows
2000 Professional, or
Windows XP) you can
use the OS’s “Power
Options” control panel
to set the power button
to send the system into
Standby or Hibernate
mode (see your OS’s
documentation, or
“Configuring the
Power Button” on
page 4 - 8 for details).
- 2 The Power Sources
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press
the power button on the front panel.

When the computer is on, you can use the power button as a Standby/Hiber-
nate/Shutdown hot-key button when it is pressed for less than 4 seconds
(pressing and holding the power button for longer than this will shut the com-
puter down). Use Power Options in the Windows control panel to configure
this feature.

Shutdown

Note that you should
always shut your com-
puter down by choos-
ing the Shut Down/
Turn Off Computer
command from the
Start menu in Win-
dows. This will help
prevent hard disk or
system problems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press
the power button for 4 seconds, or longer, to force the system to turn itself off.
Turning on the Computer 4 - 3
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Power Schemes
You can set your computer to conserve power through individual components
by means of Power Schemes. You can also adjust the settings for each
scheme to set the monitor to turn off after a specified time, and the computer's
hard disk motor to turn off if the hard disk drive has not been accessed for a
specified period of time (if the system reads or writes data, the hard disk motor
will be turned back on). The schemes may also be set to set a specified time
for the system to enter Standby or Hibernate modes (see “System Power Op-
tions” on page 4 - 6).

Resuming Operation

The system can re-
sume from Monitor or
Hard Disk Standby by
pressing a key on the
keyboard.

Figure 4 - 1
Power Schemes
- 4 Power Schemes
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Each Windows Power Scheme will also adjust the processor performance of
your machine in order to save power. This is worth bearing in mind if you are
experiencing any reduced performance (especially under DC/battery power).

Choose the Home/Office Desk scheme for maximum performance when the
computer is powered from an AC power source. Choose the Max Battery
scheme (bear in mind that this scheme may slow down the overall perfor-
mance of the computer in order to save power) for maximum power saving
when the computer is battery (DC power) powered.

Windows will use Portable/Laptop as the default scheme.
Power Schemes 4 - 5
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System Power Options
You can use the system power options to stop the computer’s operation and
restart where you left off. This system features Standby and Hibernate sleep
mode levels (Hibernate mode will need to be enabled by clicking the option
in the Hibernate tab in the Power Options control panel - Figure 4 - 2 on
page 4 - 7).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you
need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left
off (what was on your desktop) without reopening the application(s) and
file(s) you last used.

You can use either method depending on your needs. 

Standby Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put the sys-
tem on standby instead of in hibernation. It takes a longer time to wake up the
system from Hibernate mode than from Standby mode.
- 6 System Power Options



Power Management

4

Standby
Standby saves the least amount of power, but takes the shortest time to return
to full operation. During Standby the hard disk is turned off, and the CPU is
made to idle at its slowest speed. All open applications are retained in memo-
ry. When you are not using your computer for a certain length of time, which
you specify in the operating system, it will enter Standby mode to save power. 

Hibernate
Hibernate uses no power and saves all of your information on a part of the
HDD before it turns the system off. Although it saves the most power it takes
the longest time to return to full operation. You can set your computer to au-
tomatically enter Hibernate mode when the battery power is almost depleted.
You will need to enable Hibernate mode from the Hibernate tab in the Power
Options control panel. The system will resume from Hibernate mode by
pressing the power button.

System Resume

The system can resume
from Standby mode by:

• Pressing the power
button

• Pressing a key on the
keyboard

• An alarm resume that
is enabled and
expires

• An incoming call
received on the
modem (if enabled)

• Network card activity
(if enabled)

Figure 4 - 2
Enable Hibernation
System Power Options 4 - 7
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Configuring the Power Button
The power button may be set to send the computer in to either Standby or Hi-
bernate mode (Figure 4 - 3). In Standby mode, the LED  will flash
green. In Hibernate mode the LED will be off. If you are in a power saving
mode set to save power through individual components (e.g. hard disk, mon-
itor), the LED will remain green.

Figure 4 - 3
Power Options

(Advanced - Power 
Buttons)

(Sleep) Button

Sleep Button

You may also configure the Sleep/Resume key combination (Fn + F4) from the
menu illustrated in Figure 4 - 3. In Windows this is referred to as the Sleep button.

Power Button Sleep/ResumeLid
- 8 Configuring the Power Button
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery
FAQ” on page 4 - 12 for instructions on how to do this).

Battery Life
Your computer’s battery life is dependent upon many factors, including the
programs you are running, and peripheral devices attached. Power Options
(you may set low battery Alarms and actions, and check the Power Meter
from the Power Options control panel), and settings in the OS will help pro-
long the battery life if configured appropriately.

Low Battery Warning

When the battery is
critically low, immedi-
ately connect the AC
adapter to the comput-
er or save your work,
otherwise, the un-
saved data will be lost
when the power is de-
pleted.

Figure 4 - 4
Power Options 
(Alarm & Power 

Meter)
Battery Information 4 - 9
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Battery life may be shortened through improper maintenance. To optimize
the life and improve its performance, fully discharge and recharge the
battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to
remove the battery for any reason see “Removing the Battery” on page 7 - 3.

Recharging the Battery with the AC Adapter
The battery pack automatically recharges when the AC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it
will take several hours to fully recharge the battery. When the computer is
turned off but plugged into an electrical outlet, battery charge time is less. (Re-
fer to “LED Indicators” on page 1 - 6 for information on the battery charge
status, and to “Battery Information” on page 4 - 9 for more information on
how to maintain and properly recharge the battery pack.)

Conserving Battery 
Power

To conserve battery pow-
er:

Lower the brightness lev-
el of the LCD display. The
system will decrease LCD
brightness slightly to save
power when it is not pow-
ered by the AC adapter.
Close modem or commu-
nication applications
when they are not being
used.
Remove any unused PC
Cards from the computer
(PC Cards quickly use up
battery power even if the
system enters sleep
mode).
Disconnect any unneces-
sary external devices.
- 10 Battery Information
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after
being dropped), or any unusual smells emanating from the notebook battery, shut
your computer down immediately and contact your service center. If the battery has
been dropped we do not recommend using it any further, as even if the computer
continues to work with a damaged battery in place, it may cause circuit damage,
which may possibly result in fire. It is recommended that you replace your computer
battery every two years.
Battery Information 4 - 11
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery.
Don’t turn off the computer by yourself even when you see a message that in-
dicates the battery is critically low, just let the computer use up all of the bat-
tery power and shut down on its own. Disable the Power Options functions
in the Control Panel, especially any Alarms (unclick the tickboxes - see 4 -
9) and Schemes (change all the settings to Never - see page 4 - 4). As the bat-
tery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light
changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or af-
ter about 20 partial discharges.

Caution

Danger of explosion if
battery is incorrectly
replaced.

Replace only with the
same or equivalent
type recommended by
the manufacturer. Dis-
card used battery ac-
cording to the
manufacturer’s in-
structions.
- 12 Battery Information
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Chapter 5: Drivers & Utilities
This chapter deals with installing the drivers and
utilities essential to the operation or improvement
of some of the computer’s subsystems. The system
takes advantage of some newer hardware compo-
nents for which the latest versions of most available
operating systems haven’t built in drivers and utili-
ties. Thus, some of the system components won’t
be auto-configured with an appropriate driver or
utility during operating system installation. Instead,
you need to manually install some system-required
drivers and utilities. In this chapter, we group driver
and utility installation instructions by operating
system. The following operating systems are cov-
ered.

• Windows 2000 Professional
• Windows XP Professional and Home Editions

What to Install
The Device Drivers & Utilities + User’s Manual
CD-ROM contains the drivers and utilities neces-
sary for the proper operation of the computer. (The
Intel Wireless LAN module driver, and the op-
tional Bluetooth module driver and optional PC
Camera driver are on the separate CD-ROMs sup-
plied.) Table 5 - 1, on page 5 - 7 lists what you need
to install manually according to your choice of the
operating system, and it is very important that the
drivers are installed in the order indicated.

Module Driver Installation
The procedures for installing drivers for the Wire-
less LAN, Bluetooth, TV Tuner, PC Camera,
and RAID modules are provided in “Modules” on
page 8 - 1. Make sure that the drivers are installed
in the order indicated in Table 5 - 1, on page 5 - 7.
If your purchase does not include any of the mod-
ules, DO NOT install the drivers for them.
What to Install 5 - 1
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Navigate (Browse..) to D:

You will notice that many of the instructions for driver
installation require you to “Navigate (Browse) to D:”.
We assume that you will install all drivers and utilities
from the built-in CD device and it is assigned to “Drive
D:”. In addition, all file extensions can be seen

In this case “D:” is the drive specified for your CD de-
vice. Not all computers are setup the same way, and
some computers have the CD listed under a different
drive letter - e.g. if you have two hard drives (or hard
disk partitions) one may be designated as “Drive C:”
and the other as “Drive D:”. In this case the CD device
may be designated as “Drive E:” - Please make sure
you are actually navigating to the correct drive letter
for the CD device.

When you click the Browse (button) after clicking
Run in the Start menu you will see the “Look in:” di-
alog box at the top of the Browse window. Click the
scroll button to navigate to My Computer to display
the devices and drive letters. Figure 5 - 1 - Navigate (Browse..) to.. 
- 2 What to Install
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Service Packs
Check the warnings on the following pages regard-
ing installation of the appropriate Service Pack for
your Windows OS. If you are unsure of the Service
Pack currently installed see below. Make sure you
have installed the appropriate Service Pack before
installing all the drivers.

Service Pack Installed

To see which Service Pack is currently installed on
your computer go to the General tab of the System
control panel. Right-click the My Computer icon on
the desktop or in the Start menu (in WinXP only) and
select Properties. The Service Pack currently in-
stalled on your system will be listed under the “Sys-
tem:” heading. (If no Service Pack information is
listed, then no Service Pack is installed.)

Windows 2000 with Service Pack 4

Make sure that your Windows 2000 version in-
cludes Service Pack 4 on the installation CD.
What to Install 5 - 3
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Windows XP Service Pack 1

Make sure you install Windows XP Service Pack 1(or a Windows XP version which includes Service Pack 1)
before installing any drivers. Service Pack 1 includes support for USB 2.0.
If you have upgraded the system by installing Service Pack 1 (i.e. your Windows XP version does not include
Service Pack 1) then follow these instructions:

1.If you can see the My Computer icon on your desktop (if you cannot see the My Computer icon go to step 2)
click on it once to select it, then right-click it to make the sub-menu appear and scroll down to Properties and
click on it (go to step 3).

2.If you cannot see the My Computer icon click Start (menu), then point to (but don’t click just highlight it) My
Computer. Right-click it to make the sub-menu appear and scroll down to Properties and click on it (go to step
3).

3.Click the Hardware (tab), then click Device Manager (button). 
4.Click “+” next to Other Devices (if its sub-items are not shown).
5.If you see the Universal Serial Bus (USB) Controller item, right-click and select Uninstall > OK (if you don’t

see the item then there is no need to take any further action).
6.Restart the computer and it will find the USB 2.0 controller.
- 4 What to Install
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Authorized Driver Message
If you receive a message telling you that the driver
you are installing is not authorized (Digital Signa-
ture Not Found), just click Yes or Continue Any-
way to ignore the message and continue the
installation procedure.

You will receive this message in cases where the
driver has been released after the version of Win-
dows you are currently using. All the drivers pro-
vided will have already received certification for
Windows.

Version Conflict Message
During driver installation if you encounter any “file
version conflict” message, please click Yes to
choose to keep the existing (newer) version.

Updating/Reinstalling Individual 
Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To
do this go to the Control Panel in the Windows OS
and double-click the Add/Remove Programs
item. If you see the individual driver listed (if not
see below), uninstall it, following the on screen
prompts (it may be necessary to restart the comput-
er). Go to the appropriate section of the manual to
complete the update/reinstall procedure for the
driver in question.
If the driver is not listed in the Add/Remove Pro-
grams item:
1. Click Start (menu), point to Settings and click 

Control Panel. Double-click System (icon) and 
then click Hardware (tab) > Device Manager 
(button).

2. Double-click the device you wish to update/
reinstall the driver for (you may need to click 
“+”).

3. Look for the Update Driver button (check the 
Driver tab) and follow the on screen prompts.
What to Install 5 - 5
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Driver Installation
Insert the Device Drivers & Utilities + User’s Man-
ual CD-ROM and the Notebook Driver Installa-
tion application will run automatically. If you want
to install the driver manually see “Manual Driver
Installation” on page 5 - 7.

1. Check the driver installation order from Table 5 - 
1, on page 5 - 7 (the drivers must be installed 
in this order) which is the same as that listed in 
the application menu.

2. Double-click to select the name of the driver you 
wish to install.

3. Follow the instructions as listed in this chapter.
4. Make a note of the drivers you have installed.
5. If the computer needs to restart after installing a 

driver, and you will usually need to click the 
“Yes/Finish” button when prompted to restart 
the computer.

6. To get back to the Driver Installation screen click 
Start (menu) > Run... and navigate (Browse..) 
to D:\SETUP.EXE and click OK. 
OR 

Double-click the My Computer icon (for WinXP 
only), and then double-click the CD icon.

Figure 5 - 2
Drivers Installer

Note: The installation procedure for installing the
Audio and Modem drivers will differ according to
your operating system (see page 5 - 9).
- 6 Driver Installation
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Manual Driver Installation
If you wish to install the drivers manually, click the Exit button to quit the Notebook Driver Installation
application, then follow the manual installation procedure for each driver. The manual installation proce-
dure begins with instructions on how to browse to the executable file; “Click Start (menu) > Run..”.

Feature Windows 2000 (SP4) Windows XP (SP1)

Chipset page 5 - 9

Table 5 - 1
Driver 

Installation

Audio page 5 - 10 page 5 - 9

Modem page 5 - 10 N/A Installed along with Audio Driver 

Network (LAN) page 5 - 11

Video page 5 - 11

Hot-Key page 5 - 11

TouchPad page 5 - 12

Auto Mail Checker page 5 - 12

IPN2220 802.11g Wireless See page 8 - 4

Bluetooth & WLAN Combo See pages 8 - 5 & 8 - 7

TV Tuner Applications See pages 8 - 9 & 8 - 10

PC Camera See page 8 - 11
Driver Installation 5 - 7
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Windows XP & 2000 Professional
This section covers driver and utility installation in-
structions for Windows XP (Professional & Home)
and Windows 2000 Professional.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the
installation procedure (other than when outlined
in the driver install procedure), click Cancel to
close the window, and follow the installation proce-
dure.

Windows XP Service Pack 1

Make sure you install Windows XP Service Pack 1
(or a Windows XP version which includes Service
Pack 1) before installing any drivers. Service
Pack 1 includes support for USB 2.0.
If you have upgraded the system by installing Ser-
vice Pack 1 (i.e. your Windows XP version does not
include Service Pack 1) then follow the instructions
in “Windows XP Service Pack 1” on page 5 - 4.

Windows 2000 with Service Pack 4

Make sure that your Windows 2000 version in-
cludes Service Pack 4 on the installation CD.
- 8 Windows XP & 2000 Professional
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Chipset (WinXP & 2000)
1. Double-click CHIPSET from the Notebook 

Driver Installation menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Driv-
ers\CHIPSET\Setup.exe and click OK.

2. Click Next > Yes > Next.
3. Click Finish to restart the computer.

The procedure for installing the Audio and Modem
drivers will differ, depending on your operating
system.

Audio & Modem (Win2000)
1. Double-click AUDIO from the Notebook 

Driver Installation menu. 
OR
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\AUDIO\Setup.exe 
and click OK.

2. Click Next.
3. Click Next when The Found New Hardware 

Wizard appears.
4. Select “Search for a suitable driver for my 

device (recommended)” and click Next.
5. Select ONLY “Specify a location” and click 

Next.
6. Navigate (Browse...) to 

D:\Drivers\MODEM\WIN2K.
7. Click Open > OK > Next (click Yes if asked if 

you want to continue at any time).
8. Click Finish > Finish to restart the computer.
9. Click Yes to restart the computer (click cancel 

if The Found New Hardware Wizard appears).
Windows XP & 2000 Professional 5 - 9
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Audio (WinXP)
1. Double-click AUDIO from the Notebook 

Driver Installation menu. 
OR
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\AUDIO\Setup.exe 
and click OK.

2. Click Next (click Cancel if The Found New 
Hardware Wizard appears).

3. Click Finish to restart the computer.
4. When the computer restarts click Cancel if the 

The Found New Hardware Wizard appears 
(click Continue Anyway if asked if you want 
to continue at any time).

5. Click Yes to restart the computer (click Cancel 
if The Found New Hardware Wizard appears).

Modem (WinXP)
1. Double-click MODEM from the Notebook 

Driver Installation menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Driv-
ers\MODEM\WINXP\Setup.exe and click 
OK.

2. Click  (button).
3. Click .
4. The modem is ready for dial-up configuration.

Modem Country Selection

Be sure to check if the modem country selection is ap-
propriate for you (Control Panel > Phone and Mo-
dem Options).
- 10 Windows XP & 2000 Professional
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LAN (WinXP & 2000)
1. Double-click LAN from the Notebook Driver 

Installation menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\LAN\Setup.exe and 
click OK.

2. Click Next.
3. Click Finish.
4. The network settings can now be configured.

Video (WinXP & 2000)
1. Double-click VIDEO from the Notebook 

Driver Installation menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\VIDEO\setup.exe 
and click OK.

2. To continue click Next (click Continue 
Anyway/Yes if asked if you want to continue at 
any time).

3. Click Finish/OK to restart the computer.
4. See “NVIDIA Video Driver Controls” on 

page 3 - 3 for details on adjusting the video 
settings.

Hot-Key (WinXP & 2000)
1. Double-click AP-KEY from the Notebook 

Driver Installation menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\AP-KEY\Setup.exe 
and click OK.

2. Choose the language you prefer, and click OK.
3. Click Next.
4. Click Finish to restart your computer.
Windows XP & 2000 Professional 5 - 11
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TouchPad (WinXP & 2000)
1. Double-click TOUCHPAD from the Notebook 

Driver Installation menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse...) to D:\Drivers\TOUCH-
PAD\WinXP or Win2K\Setup.exe and click 
OK.

2. Click Next > Next > Next (click Continue 
Anyway/Yes if asked if you want to continue at 
any time).

3. Click Finish to restart your computer.
4. You may then configure your TouchPad as 

outlined in “Configuring the TouchPad and 
Buttons” on page 2 - 12.

Auto Mail Checker (WinXP & 2000)
1. Double-click AUTOMAIL from the Notebook 

Driver Installation menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\AUTO-
MAIL\SETUP.EXE and click OK. 

2. To continue click Next > Next > Finish.
3. Run the program from the Auto Mail Checker 

in the Start menu (Start > Programs/All 
Programs > Auto Mail Checker).

4. For further details see “Check Mail Program” 
on page 2 - 8.
- 12 Windows XP & 2000 Professional
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Module Drivers
See the following pages for the driver installation
procedures for any modules included in your pur-
chase option.

Wireless LAN (WinXP & 2000)
See install procedure in “CastleNet IPN2220
(802.11g) Wireless LAN Driver Installation
(WinXP & 2000)” on page 8 - 4.

WLAN & Bluetooth Combo (WinXP & 
2000)
See install procedure in “Combo Module Blue-
tooth Driver Installation (Win2000)” on page 8 -
5 & “Combo Module WLAN Driver Installation
(WinXP)” on page 8 - 7.

PC Camera (WinXP & 2000)
See install procedure in “PC Camera Driver In-
stallation (WinXP & 2000)” on page 8 - 11.
Windows XP & 2000 Professional 5 - 13
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Chapter 6: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important changes
to the system (e.g. hard disk setup), then you should review this chapter first
and note the original settings found in Setup. Even if you are a beginner, keep
a record of the settings you find and any changes you make. This information
could be useful if your system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what
you are doing. Many of the settings are required by the system, and changing
them could cause it to become unstable or worse. If you have any doubts, con-
sult your service representative.

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to
Setup and restore the
Setup Defaults with
<F9>.
Overview 6 - 1
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The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to con-
duct a POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong.
If there is a problem that prevents the system from booting, it will display a
system summary and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will
load the operating system. Once that starts, you can’t get into Setup without
rebooting.

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST
screen as pictured is
for guideline purposes
only. The POST
screen on your compu-
ter may appear slightly
different.

Figure 6 - 1
POST Screen

Phoenix cME FirstBIOS Notebook Pro
Copyright 1985-2003 Phoenix Technologies Ltd.
All Rights Reserved
BIOS Revision: V133 1.00.E08
KBC/EC Firmware Revision: 1.00.E5
VBIOS Revision: VER008.017M.202-000-2004/06/07

CPU = Intel(R) Pentium(R) 4 CPU 3.20GHz
255M System RAM Passed
1024K Cache SRAM Passed
System BIOS shadowed
Video BIOS shadowed
ATAPI CD-ROM: QSI CD-RW/DVD-ROM SBW242B
USB: Y-E DATA USB-FDU
Mouse intialized

Press <F2> to enter SETUP

1

2
3

4

- 2 The Power-On Self Test (POST)



BIOS Utilities

6

Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and
“non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously
wrong with your system. Take the computer to your service representative or
authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying
the problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup 

Press F1 to see if the boot process can continue. It may work, without the cor-
rect configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still
get an error message after you change the setting, or if the “cure” seems even
worse, call for help.
The Power-On Self Test (POST) 6 - 3
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The Setup Program
The Phoenix Setup program tells the system how to configure itself and man-
age basic features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The
prompt (Press F2 to Enter Setup) seen in Figure 6 - 1 is usually present for a
few seconds after you turn on the system. If you get a “Keyboard Error”, (usu-
ally because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combina-
tion and then hold down F2 when prompted. The Setup main menu will ap-
pear.
- 4 The Setup Program
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with five (5) menu headings. When
you select a heading, a new screen appears. Scroll through the features listed
on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of
the screen. If these tools are confusing, press F1 to call up a General Help
screen, then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlight-
ed item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that
subject. The sub-menu screen that appears has a similar layout, but the Enter
key may execute a command.

Setup Menus

The Setup menus
shown in this section
are for reference only.
Your computer’s men-
us will indicate the con-
figuration appropriate
for your model and op-
tions.
The Setup Program 6 - 5
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If
you can change the date and time settings in your operating system, you will
also change these settings. Some applications may also alter data files to re-
flect these changes.

Figure 6 - 2
Main Menu

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

<Tab>, <Shift Tab>, or
<Enter> selects field.

System Time: [22:11:05]
System Date: [09/22/2004]

�IDE 0 [CD-ROM]
�IDE 1 [None]

Installed memory 256 MB
Available to OS 254 MB
Used by devices 2 MB

Main

13
- 6 Main Menu
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IDE 0/1 (Main Menu)
Pressing Enter under opens the sub-menu to show the configuration of the ei-
ther a CD Device or HDD that on the computer’s IDE Channels 0 or 1. Use
the Auto (Type:) setting to have the items configured automatically for you.

Installed memory (Main Menu)
This item contain information on the system memory, and is not user config-
urable. The system will auto detect the amount of memory installed, the
amount used by devices, and the unused memory available to the operating
system (OS).
Main Menu 6 - 7
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Advanced Menu

System Information (Advanced Menu)
Pressing Enter here will provide valuable information on your system includ-
ing CPU type and speed etc.

Figure 6 - 3
Advanced Menu

PhoenixBIOS Setup Utility

Main Advanced Security Power Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific HelpSetup Warning
Setting items on this menu to incorrect
values may cause your system to malfunction.

�System Information
�I/O Device Configuration

Reset Configuration Data: [No]

Hyper Threading Technology: [Enabled]
Power On Beep [Disabled]
Card Reader : [Enabled]
RAID/ATA Mode Select [RAID Mode]

Advanced
- 8 Advanced Menu
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I/O Device Configuration (Advanced Menu)
The sub-menus under this item include options to configure the Serial port A
(Serial Mouse), Serial port B (Infrared) and Parallel (Printer) port. These
can be left to the default settings, however you may wish to use certain devices
that require settings to be adjusted accordingly. Check the documentation for
any such devices to see what settings are required.

Reset Configuration Data (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have
installed a new add-on which has reconfigured the system, resulting in such a
serious system conflict that the operating system is unable to boot.

Hyper-Threading Technology (Advanced Menu)
Enable Hyper-Threading (it is “Enabled” by default) to increase performance
of your computer depending on the hardware and software you use (all the
processor options in this notebook series support Hyper Threading Technolo-
gy). Hyper Threading is supported fully in Windows XP, but it is strongly
recommended you DO NOT enable this option in Windows 2000. Once
you have enabled Hyper-Threading, DO NOT disable the option. (If you
do disable the option you will need to reinstall your operating system.)
Advanced Menu 6 - 9
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Power On Beep (Advanced Menu)
Use this menu to enable/disable the single beep sound at the end of the POST.
This item is “Disabled ” by default.

Card Reader: (Advanced Menu)
This option allows you to enable/disable support for the 7-in-1 Card Reader.
and is “Enabled” by default. However if you are installing an operating sys-
tem (e.g. Windows XP) it is recommended that you disable the card read-
er, as otherwise the card reader slots will automatically be defined as
drives “C:” through “F:” (your hard disk drive will then be defined as
drive “G:” etc.). If you set this option to “Disabled” in order to install the op-
erating system, don’t forget to reset the option to “Enabled” after you have in-
stalled the operating system.

RAID/ATA Mode Select: (Advanced Menu)
Configure your hard disks in RAID or ATA mode here (if you have included
the extra hard disk and RAID option in your purchase configuration).
- 10 Advanced Menu
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Setup utility. This will not affect ac-
cess to the computer OS, (only the Setup utility) unless you choose to set a
Password on Boot (see below).

Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure 6 - 4
Security Menu

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Supervisor Password
controls access to the
setup utility.

Security

Supervisor Password Is: Clear

Set Supervisor Password [EEnter]

Password on boot: [Disabled]
Security Menu 6 - 11
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Password on boot: (Security Menu)
Specify whether or not a password (supervisor or user password) should be
entered to boot the computer. If “Enabled” is selected, only users who enter a
correct password can boot the system (see the warning in the sidebar). The
default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password,
then press Enter for the new password (without typing any password entry)
and Enter again to confirm the password clearance.

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
- 12 Security Menu
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Win-
dowsXP) from the devices listed in this menu, and in this priority order. If it
cannot find the operating system on that device, it will try to load it from the
next device in the order specified in the Boot priority order. Item specific
help on the right is available to help you move devices up and down the order.

Figure 6 - 5
Boot Menu

PhoenixBIOS Setup Utility

Main Advanced Security Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Keys used to view or
configure devices:
Up and Down arrows
select a device.
<+> and <-> moves the
device up or down.
<f> and <r> specifies
the device fixed or
removable.
<x> exclude or include
the device to boot.
<Shift + 1> enables or
disables a device.
<1 - 4> Loads default
boot sequence.

Boot priority order:
1: USB FDC: Y-E DATA USB-FDU-(USB)
2: IDE 0: TOSHIBA DVD-ROM SD-C2612-
3: PCI SCSI: FT TX Ary 1
4: IDE 1:
5:
6:
7:
8:

Excluded from boot order:
: USB HDD
: USB CDROM

Boot
Boot Menu 6 - 13
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Boot devices usually are hard drives, floppy drives, and CD-ROMs.

When you specify a device as a boot device on the Boot Menu, it requires the
availability of an operating system on that device. Most home computers
come with an operating system already installed on “Drive C:”.

If you wish to boot from a CD-ROM you will need to add it to the boot order.
As a general rule the order below is recommended:

1. Removable Devices (usually floppy disks)
2. CD-ROM/DVD-ROM Drive
3. Hard Drive

In everyday use you will usually boot from the hard drive, however there may
be occasions when it is advantageous to boot from a floppy disk or CD-ROM/
DVD-ROM.
- 14 Boot Menu
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out
any changes you have made to the Setup. You can also choose to restore the
original Setup defaults that will return the Setup to its original state, and erase
any previous changes you have made in a previous session.

Figure 6 - 6
Exit Menu

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Exit System Setup and
save your changes to
CMOS.

Exit Saving Changes
Exit Discarding Changes
Load Setup Defaults
Discard Changes
Save Changes

Exit
Exit Menu 6 - 15
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Chapter 7: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the
steps outlined to make the desired upgrades. If you have any trouble or prob-
lems you can contact your service representative for further help. Before you
begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an anti-
static wrist strap to ground yourself because static electricity may damage the
components.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk(s)
• Upgrading the System Memory
• Upgrading the Optical CD/DVD Device(s)
Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 7 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes
replacing parts.

You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase
or replace the component(s).

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, re-
member to replace the cover(s) and screw(s) before turning the computer on.
- 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety
reasons it is best to remove the battery.
1. Turn the computer off, and turn it over.
2. Loosen screws  - .
3. Release the battery, and lift the battery  out of the battery bay.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

1 3
4

1 2 3

4

Figure 7 - 1
Battery Removal
Removing the Battery 7 - 3
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Upgrading the Hard Disk Drive(s)
The hard disk drive(s) can be taken out to accommodate other 2.5" IDE hard
disk drives with a height of 9.5mm (h) (see “Storage Options” on page  B -
3). Follow your operating system’s installation instructions, and install all
necessary drivers and utilities (as outlined in“Drivers & Utilities” on page 5
- 1), when setting up a new hard disk.

HDD System 
Warning

New HDD’s are blank.
Before you begin make
sure:
You have backed up any
data you want to keep
from your old HDD.
You have all the CD-
ROMs and FDDs re-
quired to install your oper-
ating system and
programs.
If you have access to the
internet, download the lat-
est application and hard-
ware driver updates for
the operating system you
plan to install. Copy these
to a removable medium.

Hard Disk Jumper Settings for RAID

If you are using two hard disk in a RAID configuration in your computer, make
sure to set the jumper on the slave hard disk to the cable select option in order
for the system to recognize the disks (see your hard disk manual or the information
printed on the hard disk itself for details on the jumper settings). The slave disk will
automatically be in the upper slot of the hard disk case, the master will be in the
lower slot (as defined by the hard disk cable).

Configure the RAID according to the instructions on  Chapter 8:“RAID Configura-
tion” on page 8-16.
- 4 Upgrading the Hard Disk Drive(s)
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1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  - .
3. Remove the bay cover .

1 4
5

Figure 7 - 2
HDD Bay Cover 

Removal

1

3 4

2

5

Upgrading the Hard Disk Drive(s) 7 - 5
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4. Release the cable  and lift the hard disk assembly  up out off the 
computer.

5. Remove screws  -  in order to separate the bracket from the hard 
disk(s), and disconnect the cable .

6. Reverse the process to install a new hard disk(s).

6 7

8 15
16

Figure 7 - 3
HDD Assembly 

Removal

67

8
9

10 16
11

13
12

15
14
- 6 Upgrading the Hard Disk Drive(s)
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Upgrading the System Memory (RAM)
The computer has four memory sockets for 200 pin Small Outline Dual In-
line (SO-DIMM) - DDR-II (DDR2) - type memory modules (see “Memory”
on page B - 2). The total memory size is automatically detected by the POST
routine once you turn on your computer. 
1. Turn off the computer, and turn it over and remove the battery.
2. Locate the memory (RAM) bay cover and remove screws  - , and 

carefully (the fan cable will still be attached) lift off the bay cover .

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

Figure 7 - 4
RAM Cover 

Removal

1 4
5

1
52

34
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3. Gently pull the two release latches (  & ) on the sides of the memory 
socket in the direction indicated by the arrows in Figure 7 - 5.

4. The RAM module  will pop-up, and you can remove it.
5. Pull the latches to release the second module if necessary.
6. Insert a new module holding it at about a 30° angle and fit the connectors 

firmly into the memory slot.
7. The module’s pin alignment will allow it to only fit one way. Make sure the 

module is seated as far into the slot as it will go. DO NOT FORCE the 
module; it should fit without much pressure.

8. Press the module in and down towards the mainboard until the slot levers 
click into place to secure the module.

9. Replace the memory socket cover and the 2 screws (see Figure 7 - 4).
10. Restart the computer to allow the BIOS will register the new memory 

configuration as it starts up.

6 7

76

76

8 8

8

Figure 7 - 5
RAM Module 

Removal
- 8 Upgrading the System Memory (RAM)
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Upgrading the Optical (CD/DVD) Device(s)
1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  - , and remove 

the bay cover.
3. Remove screw  and use the screwdriver to push the optical device(s) out 

of the computer at point .

Figure 7 - 6
Removing the CD/

DVD Device(s)

1 4

5
6

1

3 4

2

5

6

Upgrading the Optical (CD/DVD) Device(s) 7 - 9
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Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with
a faster/new one you will need to contact your customer service representa-
tive. We recommend that you do not do this yourself, since if it is done incor-
rectly you may damage the processor or mainboard.

Warranty

The CPU is not a user
serviceable part.
Opening this compart-
ment, or accessing the
CPU in any way, may
violate your warranty.

Unauthorized tamper-
ing with the HDD may
also violate your war-
ranty.
- 10 Upgrading the Processor
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Chapter 8: Modules
Overview
This chapter contains the information on the various modules (some of which
are optional) which may come with your computer, depending on the config-
uration purchased. If you are unsure please contact your service representa-
tive.

The chapter includes information on the following:

• The Wireless LAN Module Options
• The Bluetooth & WLAN Combo Module
• The TV Tuner
• PC Camera
• RAID
Overview 8 - 1
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The Wireless LAN & Bluetooth Modules
If your purchase option includes the any of the Wireless LAN modules and/or
Bluetooth and Wireless LAN combination module, follow the information on
the following pages for instructions on installing the driver. Pay careful atten-
tion to the warnings concerning the use of wireless modules aboard aircraft,
and the instructions on enabling/disabling power to the modules.

Wireless Device 
Operation Aboard 

Aircraft

The use of any porta-
ble electronic trans-
mission devices
aboard aircraft is usu-
ally prohibited. Make
sure the module(s) are
OFF if you are using
the computer aboard
aircraft. When the
computer first ‘Boots
Up’ the module(s)   will
be OFF. 

If you restart the com-
puter the power status
of the module will re-
main the same as it
was before the restart.
If you shut down the
computer the module
will turn OFF.

Power Toggle for the Wireless LAN and Bluetooth Modules

You will need to enable power to the modules by using the following key combina-
tions:

Fn + F11 = Wireless LAN Module Power Toggle
Fn + F12 = Bluetooth Module Power Toggle

When the Wireless LAN module is powered on, the  LED will be green.

When the Bluetooth module is powered on, the  LED will be orange.

Do not try to use the Wireless LAN module and the Bluetooth module at the same
time, as this may cause a communication conflict.
- 2 The Wireless LAN & Bluetooth Modules
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Mini PCI Wireless LAN Module
Before installing the Wireless LAN driver, make sure that the optional
WLAN module is on (the  LED will be green). 

Use the WLAN module key combination Fn + F11 to toggle power to the
WLAN module. Make sure you install the drivers in the order indicated in
Table 5 - 1, on page 5 - 7.

You will be provided with the appropriate driver CD for your module. Insert
the CD and follow the installation procedure.

Wireless Device 
Operation Aboard 

Aircraft

The use of any porta-
ble electronic trans-
mission devices
aboard aircraft is usu-
ally prohibited. Make
sure the module(s) are
OFF if you are using
the computer aboard
aircraft. When your
computer ‘Boots Up’
the modules will be
ON. 

If you restart the com-
puter the power status
of the module will re-
main the same as it
was before the restart.
If you shut down the
computer the module
will turn OFF.
Mini PCI Wireless LAN Module 8 - 3
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CastleNet IPN2220 (802.11g) Wireless LAN Driver Installation
(WinXP & 2000)
1. Insert the Wireless LAN CD-ROM into the CD/DVD drive.
2. Click Start (menu) > Run...
3. Navigate (Browse..) to D:\setup.exe and click OK.
4. Click Next.
5. Click the button to accept the license agreement, then click Next.
6. Click Install > Finish.
7. Access any available wireless networks from Network Connections 

control panel in Windows (see sidebar).

The INPROCOMM Wireless LAN Configuration Utility may be run from
the Start menu (Start > Programs/All Programs > Inprocomm), and may
then be accessed from the icon  in the taskbar.

Network Connection

Use the Windows
Network Connec-
tions control panel to
access available wire-
less networks (Start >
Settings > Network
Connections or Start
> Connect To > Show
all Connections).

Figure 8 - 1
INPROCOMM 
WLAN Utility
- 4 Mini PCI Wireless LAN Module
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Bluetooth/WLAN Combo Module
Before installing the Bluetooth/WLAN driver, make sure that the optional
Bluetooth module/WLAN is on. Use the Bluetooth module key combina-
tion Fn + F12 to toggle power to the Bluetooth module. Use the WLAN
module key combination Fn + F11 to toggle power to the WLAN module
(the  LED will be orange for Bluetooth and green for WLAN). Make
sure you install the drivers in the order indicated in Table 5 - 1, on page 5 - 7.

Combo Module Bluetooth Driver Installation (Win2000)
1. Insert the Bluetooth/WLAN Combo CD-ROM into the CD drive.
2. The program will run automatically.
3. Click Install Bluetooth Driver and click Next.
4. Click the button to accept the license agreement, then click Next.
5. Click Next > Install (click OK if asked if you want to continue).
6. Click Finish > Yes to restart the computer.
7. You can configure the settings in the Bluetooth Configuration control 

panel (Start menu and point to Settings and click Control Panel then 
double-click the Bluetooth Configuration icon).

The User Guide (UsrGuide.pdf) is on the Bluetooth/WLAN Combo CD-
ROM in the D:\Software\Bluetooth Software folder. Install adobe Acrobat
in order to read the file (it is on the Device Drivers & Utilities + User’s Man-
ual CD-ROM).

Wireless Device 
Operation Aboard 

Aircraft

The use of any porta-
ble electronic trans-
mission devices
aboard aircraft is usu-
ally prohibited. Make
sure the module(s) are
OFF if you are using
the computer aboard
aircraft. When your
computer ‘Boots Up’
the modules will be
ON. 

If you restart the com-
puter the power status
of the module will re-
main the same as it
was before the restart.
If you shut down the
computer the module
will turn OFF.
Bluetooth/WLAN Combo Module 8 - 5
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Combo Module Bluetooth Driver Installation (WinXP)
1. Insert the Bluetooth/WLAN Combo CD-ROM into the CD drive.
2. The program will run automatically.
3. Click Install Bluetooth Driver and click Next.
4. Click the button to accept the license agreement, then click Next.
5. Click Next > Install (click OK/Continue Anyway if asked if you want 

to continue).
6. When the Found New Hardware Wizard appears click (click the No, not 

this time button) Next.
7. Make sure install the software (automatically) is selected, and click 

Next.
8. Click Finish.
9. You can configure the settings in the Bluetooth Configuration control 

panel (Start menu and point to Settings and click Control Panel then 
double-click the Bluetooth Configuration icon).

The User Guide (UsrGuide.pdf) is on the Bluetooth/WLAN Combo CD-
ROM in the D:\Software\Bluetooth Software folder. Install adobe Acrobat
in order to read the file (it is on the Device Drivers & Utilities + User’s Man-
ual CD-ROM).
- 6 Bluetooth/WLAN Combo Module
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Combo Module WLAN Driver Installation (WinXP)
1. Insert the Bluetooth/WLAN Combo CD-ROM into the CD drive.
2. The program will run automatically.
3. Click Install WLAN Driver and click Next.
4. Click the button to accept the license agreement, then click Next.
5. Click Install (click OK if asked if you want to continue).
6. Click Finish.
7. Access any available wireless networks from Network Connections 

control panel in Windows (see sidebar).

The WLAN Utility may be run by clicking the desktop icon , or from the
Start menu (Start > Programs/All Programs > WLAN). It may then be ac-
cessed from the icon  in the taskbar.

Network Connection

Use the Windows
Network Connec-
tions control panel to
access available wire-
less networks (Start >
Settings > Network
Connections or Start
> Connect To > Show
all Connections).

Figure 8 - 2
WLAN Utility
Bluetooth/WLAN Combo Module 8 - 7
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TV Tuner
The optional TV Tuner allows you to watch TV, play music CDs, video con-
ference and capture still images and video on your PC.
The TV Tuner comes with a remote control unit, and CDs containing AverTV
Utility software), and InterVideo WinDVD 4 software. Make sure you install
the applications from the CDs provided, then consult the guides for full in-
structions on how to use the TV Tuner and TV Studio software. The CATV-
In jack and S-Video-In jack will only be enabled when the TV Tuner
module is installed. Make sure you install the software before connecting
the coaxial cable to the TV antenna input.

TV Tuner Remote

The remote control unit
provided with the op-
tional TV Tuner will
only function when the
computer is powered
from the AC adapter,
and not while the com-
puter is powered by
the internal battery.

Point the remote at the
consumer IR trans-
ceiver to change
channels etc.

Figure 8 - 3
TV Tuner Ports

1. CATV Jack
2. S-Video-In Jack
3. Consumer IR 

Transceiver

21

3

- 8 TV Tuner
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Installing the AverTV Utility Software
(Win 2000)
1. Insert the AverTV Utility CD-ROM into the CD/DVD drive.
2. Click TV Utility Software.
3. Click Yes > Next > Next (click Continue Anyway/Yes if asked to con-

tinue at any time).
4. When the Found New Hardware Wizard appears click Next.
5. Select “Search for a suitable driver fro my device (recommended)” 

and click Next.
6. When Locate Driver Files appears, select ONLY “Specify a location” 

and click Next.
7. Navigate (Browse...) to D:\Driver.
8. Click Open > OK > Next (click Yes if asked to continue at any time).
9. Click Finish.
10. Run the program from the Start > Programs/All Programs > AVer TV 

menu, and select the Aver TV program, or double-click the icon on the 
desktop.

The video driver will have already installed the Microsoft DirectX 9 pro-
gram, so there is no need to reinstall it.

Insert the AverTV Utility CD-ROM and click Acrobat Reader 5.1 (button) to
install the program (if you have not already done so) to read the AVerTV
User Guide. The guide is accessible from the Start > Programs/All Pro-
grams > AVer TV menu.

PC Camera & TV 
Tuner

If you have the optional
TV Tuner included in
your purchase, make
sure you install the TV
Tuner driver and appli-
cation first. After in-
stalling the PC Camera
driver you will need to
select which device to
use with the AMCAP
program. Go to the De-
vices menu in the AM-
CAP program and
select the PC Camera
device.
TV Tuner 8 - 9
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(Win XP)
1. Insert the AverTV Utility CD-ROM into the CD/DVD drive.
2. Click TV Utility Software.
3. Click Yes > Next > Next (click Continue Anyway/Yes if asked to con-

tinue at any time).
4. Click Finish.
5. Run the program from the Start > Programs/All Programs > AVer TV 

menu, and select the Aver TV program, or double-click the icon on the 
desktop.

Insert the AverTV Utility CD-ROM and click Acrobat Reader 5.1 (button) to
install the program (if you have not already done so) to read the AVerTV
User Guide. The guide is accessible from the Start > Programs/All Pro-
grams > AVer TV menu.

Installing the InterVideo WinDVD 4 Software
(WinXP & 2000)
1. Insert the InterVideo WinDVD CD-ROM into the CD/DVD drive.
2. Click Next > Yes.
3. Type in the serial number and click Next >........ Next.
4. Click Finish.
5. Run the program from the Start > Programs/All Programs > 

InterVideo WinDVD 4 menu, and select the InterVideo WinDVD 4 
program, or double-click the icon on the desktop.
- 10 TV Tuner
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PC Camera
If your purchase includes the optional PC Camera you will need to install the
device driver for it as indicated on the following pages (make sure you install
the drivers in the order indicated in Table 5 - 1, on page 5 - 7). 

PC Camera Driver Installation (WinXP & 2000)
1. Insert the PC Camera CD-ROM into the CD Drive.
2. The program will run automatically.
3. Click Install Products and click Next.
4. Choose the language you prefer and click OK > Next.
5. Click Finish to restart the computer.
6. Run the LiveCam application software from the Bs350u2 shortcut on 

the desktop, or from the Bs350u2 item in the Start > Programs/All Pro-
grams menu (give the computer time to find the hardware).

PC Camera & TV 
Tuner

If you have the optional
TV Tuner included in
your purchase, make
sure you install the TV
Tuner driver and appli-
cation first. After in-
stalling the PC Camera
driver you will need to
select which device to
use with the LiveCam
program. Go to the De-
vices menu in the
LiveCam program and
select the BisonCam,
USB2.0 device.

Latest PC Camera Driver Information

Check the PC Camera CD, and any accompanying insert pages, for the latest up-
dated information on the PC Camera driver, which may override the information
provided here.
PC Camera 8 - 11



Modules

8

8

PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup
the audio recording options in Windows.

(WinXP)
1. Go to the Start menu and point to Settings (or just click Control Panel) and 

click Control Panel, then double-click the Sounds & Audio Devices icon 
(Sounds, Speech, and Audio Devices in Category View).

2. Click Advanced in the Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select Realtek HD Audio rear input from the Mixer Device menu.
5. Click Microphone (check box) if it is not checked, then click OK.
6. Make sure the Select (check box) in the Recording Control panel, under 

the Microphone section, is checked (boost the volume as high as it will go).
7. Close the window, then click OK.

(Win2000)
1. Go to the Start menu and point to Settings and click Control Panel then 

double-click the Sounds and Multimedia icon.
2. Click Audio (tab) and click Volume (button) in the Sound Recording menu.
3. Select Advanced Controls from the Options menu.
4. Make sure the Select (check box) in the Microphone section is checked, 

and boost the volume as high as it will go.
5. Close the window, then click OK.

Taking Still Pictures

You may take still pic-
tures in the Windows
XP operating system
only.

Double-click the My
Computer icon on the
desktop, or go the
Start menu and point
to My Computer, then
click it.

Double-click the
BisonCam, USB2.0
icon.

 

Click Take a new pic-
ture in the Camera
Tasks box.
- 12 PC Camera
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Figure 8 - 4
Audio Setup 

(Windows XP)
PC Camera 8 - 13
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LiveCam
LiveCam is a video viewer useful for general purpose video viewing and test-
ing, and can capture video files to .avi format.
 

1. Run the LiveCam program from the Start > Programs/All Programs > 
Bs350u2 menu (it is recommended that you set the capture file before the 
capture process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio make sure 
that the Capture Audio option is ticked) and select Start Capture.

3. On the first run of the program (if you have not set the captured file) you will 
be asked to choose a file name and size (see the sidebar - Pre-Allocating 
File Space) for the captured file. Click Start Capture again.

4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured 

Video As..., choose a file name and location, then click Open (you can view 
the file using the Windows Media Player).

Set Capture File
In LiveCam program you will only be asked to set the capture file name on
the first run of the program. When you run the program the next time the file
will automatically be overwritten with the newly captured file. To avoid over-
writing files you can go to the Set Capture File.. option in the File menu, and
set the file name and location before capture. Set the name and location then
click Open (you can choose Cancel to ignore the file size if prompted).

Pre-Allocating File 
Space

You may pre-allocate
the file size for the cap-
ture file in the Live-
Cam program. You
can choose to ignore
this by clicking Cancel.

Pre-allocating space
on the hard disk can
improve the capture
quality (particularly of
large capture files), by
reducing the amount of
work the hard disk has
to do in finding space
for the video data as it
is being captured.

You may find it helpful
to defragment the HDD
before capture.
- 14 PC Camera
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Eliminating Screen Flicker
If you find that the video screen in the LiveCam program is flickering, you
can try to adjust the option from the Video Capture Filter options.
1. Run the LiveCam program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click the Flicker box and choose either 50Hz or 60Hz.

Figure 8 - 5
Video Capture 

Properties
PC Camera 8 - 15
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RAID Configuration
If you have included the optional RAID (Redundant Array of Independent
Disks) configuration in your purchase option, this will allow you to use your
hard disks in combination with Striping (RAID 0) or Mirroring (RAID 1)
for fault tolerance and performance.

Hard Disk Jumper Settings for RAID

When using two hard disk in a RAID configuration in your computer, make sure
to set the jumper on the slave hard disk to the cable select option in order for the
system to recognize the disks (see your hard disk manual or the information printed
on the hard disk itself for details on the jumper settings). The slave disk will auto-
matically be in the upper slot of the hard disk case, the master will be in the lower
slot (as defined by the hard disk cable).

See  Chapter 7: “Upgrading the Hard Disk Drive(s)” on page 7 - 4 for instruc-
tions on removing the hard disk.
- 16 RAID Configuration



Modules

8

The following pages provide a basic introduction to setting up the RAID. 

RAID Level Description

RAID 0

Identical drives reading and writing data in parallel to increase
performance. RAID 0 implements a striped disk array and the
data is broken into blocks and each block is written to a sepa-
rate disk drive.

RAID 1

Identical drives in a mirrored configuration used to protect data.
Should a drive that is part of a mirrored array fail, the mirrored
drive (which contains identical data) will handle all the data.
When a new replacement drive is installed, data to the new
drive is rebuilt from the mirrored drive to restore fault tolerance.

Table 8 - 1
RAID Description
RAID Configuration 8 - 17
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RAID Setup
To create a disk array you will need to open the FastBuild Utility which is built
into the BIOS if you have included the RAID option in your purchase config-
uration. You will also need a blank floppy disk, and external USB floppy disk
drive.
Startup the computer, and when you see the screen below press the Ctrl + F
key combination to enter the utility.

If you have a disk array defined you will see a screen similar to that below.

FastTrak 378(tm) BIOS Version 1.00.1.35
(C) 2002-2005 Promise Technology, Inc. All rights reserved.

No Array is defined ...........................

Press <Ctrl-F> to enter FastBuild (tm) Utility or
Press <ESC> to continue booting......

Figure 8 - 6
FastTrak BIOS 

Screen Examples

FastTrak 378(tm) BIOS Version 1.00.1.35
(C) 2002-2005 Promise Technology, Inc. All rights reserved.

ID MODE SIZE TRACK-MAPPING STATUS

1 1x2 Mirror 30000M 3647/255/63 Functional

Press <Ctrl-F> to enter FastBuild (tm) Utility......
- 18 RAID Configuration
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You can create two types of array as outlined in Table 8 - 1, “RAID Descrip-
tion,” on page 8 - 17.

• RAID 0 - A Striped array for enhanced performance (1 or 2 drives)
• RAID 1 - A Mirrored array for data security (2 drives treated as one)

After entering the FastBuild Utility you will see the menu options below:

1. Press the number to select your setup option (Auto Setup is the easiest 
and fastest way to setup your first array - see sidebar for hard disk options).

2. Press Ctrl + Y keys to save the information.
3. Restart the computer.

Setup Options

What options are avail-
able in “Optimize Ar-
ray for” depends on
how many hard disks
you have:

1*HDD = Performance
2*HDD = Security or
Performance

In “Mode” these are
the options depending
on the number of hard
disks:

1*HDD = Stripe
2*HDD = Mirror

Figure 8 - 7
FastBuild Utility

Auto Setup....................[ 1 ]

View Drive Assignments........[ 2 ]

Define Array..................[ 3 ]

Delete Array..................[ 4 ]

Rebuild Array.................[ 5 ]

FastBuild (tm) Utility 2.01 (c) 2002-2005 Promise Technology, Inc.

[ Main Menu ]

[ Keys Avaiable ]

Press 1..5 to Select Option [ESC] Exit
RAID Configuration 8 - 19
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4. You will now need to format the array as if it were a single hard drive.
5. Have a floppy disk ready and copy the RAID\Drivers folder from the Device 

Drivers & Utilities + User’s Manual CD-ROM (Navigate/Browse.. to 
D:Drivers\RAID\FASTTRAK) to the floppy disk.

6. Startup from your operating system CD (Windows XP or Windows 2000 
including Service Pack 4).

7. Press the F6 key when you see the message “Press F6 if you need to 
install third party SCSI or RAID driver”.

8. When you see the Windows Setup menu appear, press the “S” key to 
“Specify Additional Device”.

9. Make sure you have the floppy disk with the RAID drivers copied to it 
inserted in the external USB floppy disk drive.

10. Select the appropriate controller for your operating system Windows 2000 
or Windows XP and press Enter (see below).

11. The system will now read from the floppy drive and return to the Windows 
Setup Menu.

12. Press Enter to continue installing the operating system as normal (see your 
Windows documentation if you need instructions on installing the Windows 
OS).

Figure 8 - 8
FastTrak 

Controller OS 
Select

WinXP Promise FastTrak 376/378(tm) Lite Controller
Win2000 Promise FastTrak 378(tm) Lite Controller
- 20 RAID Configuration
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Chapter 9: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you
may want to try to solve the problem yourself. This chapter lists some common problems and their possible
solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t
find the answer in these pages, make sure you have followed the instructions carefully and observed the
safety precautions in the preface. If all else fails, talk to your service representative. You should also make
a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should
preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try
turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start work-
ing again. Then call your service representative.
Overview 9 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer
appears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a 
power strip, make sure it is actually working. Check the LED Power Indicators (see “LED 
Indicators” on page 1 - 6) to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Standby mode by pressing the 
keys configured in your Power Management/Power Options (see “Configuring the Power But-
ton” on page 4 - 8), the Fn + Esc key combination, or power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust 
the brightness (see “Keyboard Video Controls” on page 3 - 2).

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display (see 
“Keyboard Video Controls” on page 3 - 2).

• Boot Drive - Make sure there are no floppy disks in any connected drive when you start up your 
machine (this is a common cause of the message “Invalid system disk - Replace the disk, and 
then press any key” / “Remove disks or other media. Press any key to restart”).
- 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to 

hand. Don’t forget to note the serial numbers if you are storing them out of their original cases, 
e.g. in a CD wallet.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule 
these programs to run at times when you are not using your computer. You can use those that are 
provided free with your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially 
important if you choose to use a Boot password for the SCU (see “Security Menu” on page 6 - 
11).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just 
brief notes).

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate
your warranty.
Backup and General Maintenance 9 - 3
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program 

which viruses to look for) up to date. New computer viruses are discovered daily, and some of 
them may seriously harm your computer and cause you to lose data. Anti-Virus programs are 
commercially available and the definitions file updates are usually downloadable directly from 
the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from 
within e-mail attachments so take care when opening any attached file. You can configure most 
Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files 
from people you know as the virus may have infected an address book and been automatically 
forwarded without the person’s knowledge.

• Keep a “Boot Floppy Disk” or “Bootable CD-ROM” (this disk provides basic information 
which allows you to startup your computer) handy. You may refer to your OS’s documentation for 
instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or 
at least instructions on how to make one).
- 4 Viruses
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what 

you are doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable 
with what you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the 
computer’s manual, but what about any new peripheral devices you have just purchased? Many 
problems are caused by the installation of new hardware and/or software. Always refer to the doc-
umentation of any new hardware and/or software, and pay particular attention to files entitled 
“READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you 
will need to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver 
files are usually available to download from vendor’s websites).
Upgrading and Adding New Hardware/Software 9 - 5
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• Thoroughly check any recent changes you made to your system as these changes may affect one 
or more system components, or software programs. If possible, go back and undo the change you 
just made and see if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the 
problem may be found; Example - if your computer has many devices plugged into its ports, and 
a number of programs running, then it will be difficult to determine the cause of a problem. Try 
disconnecting all of the devices and restarting the computer with all the peripheral devices 
unplugged. A process of elimination (adding and removing devices and restarting where neces-
sary) will often find the source of a problem, although this may be time consuming.
- 6 Upgrading and Adding New Hardware/Software
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Power

Problem Possible Cause - Solution

You turned on the power
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is
present and seated properly (the design of the battery only allows it to go in one way).
Make sure there’s nothing interfering with the battery contacts.

The Battery LED power
indicator , is blinking
orange.

Low Battery. Plug in the AC power source. If the computer doesn’t start up immediately,
turn it off then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see
“Power Schemes” on page 4 - 4) check its settings. You may also be using a PC Card
device that is drawing a lot of power.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before being recharged. Make sure the battery
is fully discharged and recharge it completely before reusing (see “Battery Information”
on page 4 - 9).

Power Options have been disabled. Go to the Control Panel in Windows and re-enable
the options.

A peripheral device or PC Card is consuming a lot of power. Turn off the unused device to
save power.
Power 9 - 7
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The computer feels too
hot.

Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If
this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour.
Make sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1 -
9). Make sure you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a travel bag
(or any such container). Putting a notebook which is powered on in a travel bag may cause
the vents/fan intakes to be blocked.

Problem Possible Cause - Solution
- 8 Power
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Display

Problem Possible Cause - Solution

Nothing appears on
screen.

The system is in a power saving mode. Toggle the sleep/resume key combination, Fn + F4
(see “Sleep Button” on page 4 - 8).
\

The screen controls need to be adjusted. Toggle the screen control key combinations Fn +
F8/F9 (see “Opening the LCD” on page 3 - 2). If you’re connected to an external monitor,
make sure it’s plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key combination, Fn
+ F7 (see “Keyboard Video Controls” on page 3 - 2). If an external monitor is
connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the
external monitor I have
plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the Control
Panel. See “What to Install” on page 5 - 1 for instructions on installing the driver, and
see “NVIDIA Video Driver Controls” on page 3 - 3 for instructions on configuring the
video driver.
Display 9 - 9
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Boot Password

Problem Possible Cause - Solution

You forget the boot
password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact
your service representative for help.

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
- 10 Boot Password
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Audio & CD Device

Problem Possible Cause - Solution

The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel
in the Windows taskbar, or use the key combination Fn + F5 and F6 (see “Audio
Features” on page 3 - 13) to adjust.

The compact disc cannot
be read.

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

The compact disc tray
will not open when there
is a disc in the tray.

The compact disc is not correctly placed in the tray. Gently try to remove the disc using the
eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes
can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on
page 2 - 5.

The Audio “DJ” CD 
Player will not turn on 
(nothing appears on the 
LCD of the player).

The computer is turned ON (see “Audio “DJ” CD Player” on page 3 - 14). Check your 
computer is not turned on (or running in a power saving mode), and if it is, then shut it 
down and toggle the ON/OFF switch on the CD Player.
Audio & CD Device 9 - 11
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Keyboard

Problem Possible Cause - Solution

Unwelcome numbers
appear when typing.

If the LED  is lit, then Num Lock is turned ON. Check that Padlock mode is not enabled
(see “LED Indicators” on page 1 - 6).

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The
system will detect and enable it automatically. However special functions/hot keys unique to the system’s regular
keyboard may not work.
- 12 Keyboard
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Operation
Problem Possible Cause - Solution

The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC adapter, press a key on
the keyboard, or press the sleep (Fn + F4) key combination, or press the power button if
no LEDs are lit.

The system never goes
into a power saving
mode.

Power Options features are not enabled. Go to the Windows Power Options menu and
enable the features you prefer (see “System Power Options” on page 4 - 6). Make sure
you have enabled Hibernate mode from the control panel.
Operation 9 - 13



Troubleshooting

9

9

Modules
Problem Possible Cause - Solution

The Wireless LAN/
Bluetooth/ modules
cannot be detected.

The modules are off. Check the LED indicator  to see if the modules are on or off
(see “LED Indicators” on page 1 - 6). If the LED indicator is off, then press the key
combination in order to enable the modules (see Table 1 - 4 “- Function Keys” on
page 1 - 8

The Wireless LAN/
Bluetooth/ modules
cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have installed the
driver for the appropriate module (see the instructions in  Chapter 8 “Modules” for the
appropriate module.

The PC Camera software
displays a black screen
when the LiveCam
software is run.

If you have both the optional PC Camera and TV Tuner modules present, go to the Devices
menu in the LiveCam program and select the BisonCam USB2.0 device (see “PC Camera
& TV Tuner” on page 8 - 11).
- 14 Modules
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Appendix A : Interface (Ports & Jacks)
Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.
A - 1
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Ports and Jacks

Item Description

Built-In Microphone The built-in microphone allows you to record on your computer 

DC-In Jack Plug the supplied AC adapter into this jack to power your computer.

Serial Port Connect a serial type mouse to this port.

Parallel Port Connect a parallel type printer to this port. The port supports ECP (Extended Capabilities
Port) and EPP (Enhanced Parallel Port) 1.7/1.9 modes.

DVI-Out Port The DVI-Out (Digital Visual Interface) Port allows you to connect an external monitor, or
Flat Panel Display, to allow dual video or simultaneous display on the LCD and external
monitor/FPD (see “Attaching Other Displays” on page 3 - 8). If you are using an older
type of monitor you will need to use a converter to convert the signal from DVI to VGA.

PS/2 Port Connect an external PS/2 type mouse or keyboard to this port. You can use a “Y” splitter if
you want to attach both.
- 2
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RJ-11 Phone Jack This port connects to the built-in modem. You may plug the telephone line directly into this
RJ-11 telephone connection. 
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

CATV-In Jack Use this jack to connect a CATV cable if you have included the optional Mini-PCI TV
Tuner in your purchase.

S-Video-In Jack The S-Video-In jack allows video input to the computer if you have included the optional
Mini-PCI TV Tuner in your purchase.

S-Video-Out Jack Connect your television to your computer and view DVDs, VCDs or anything else your
computer can display. You will need an S-Video cable to make the connection. Enable this
port from the video driver controls.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged
into the computer, and unplugged from the computer, without the need to turn the system
off (if the power rating of your USB device is 500mA or above, make sure you use the
power supply which comes with the device).

Item Description
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Mini-IEEE 1394a Ports This allows high-speed connection to various peripheral devices, e.g. external disk drives
and digital cameras (see note below).

Line-In Jack The Line-In jack allows you to play audio sources through the computer’s speakers.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your
DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s
volume to a reduced level before connecting to this jack.

Item Description

IEEE 1394

The Mini-IEEE 1394a ports only support SELF POWERED IEEE 1394 devices.
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Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can
be purchased at any computer store.

Item Description
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Appendix B: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly proces-
sor types/speeds and CD/DVD device types) may be changed or updated due to the manufacturer's release sched-
ule. Check with your service center for details.
B - 1
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Feature Specification

Processor Types Intel® Pentium® 4 520/ 530/ 540/ 550/ 560 Processor with HT Technology
LGA775 Package (775-pin)
(90nm) 90 Nanometer Process Technology, 1024KB On-Die L2 Cache & 800MHz Front Side 
Bus - 2.8/ 3.0/ 3.2/ 3.4/ 3.6 GHz

Core Logic Intel 915P + ICH6

Security Security (Kensington® Type) Lock Slot BIOS Password

Memory Two 64-bit wide DDR-II (DDR2) Data 
Channels
Four 200 Pin DDR SODIMM Sockets

Expandable up to 2814MB (Compatible with 
1024MB, 512MB, 256MB DDR-II (DDR2) 
Modules)

BIOS One 512KB Flash ROM Phoenix BIOS

LCD 17.1" WSXGA+ (1440 * 900) / WXGA (1680 * 1050) TFT LCD (16:10 Wide Screen Aspect Ratio)

Display NVIDIA NV41M High Performance Chip
256MB DDR-II (DDR2) Video RAM On Board
128-bit Graphics Engine
PCI Express * 16
Fully DirectX® 9 Support
Modular Design
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Storage Options One External USB 1.44Mb Floppy Disk Drive

One Changeable Primary 2.5" 9.5mm (h) Hard Disk Drive
One Changeable Secondary 2.5" 9.5mm (h) Hard Disk Drive RAID (Option)

Supports Serial ATA HDD
RAID 0, RAID 1, HDD Fault Tolerance System (Optional)

One Changeable Primary Optical Device Bay - 12.7 mm (h) for Optical CD/DVD Device Drive 
Options (see “Optional” on page B - 5)
One Changeable Secondary Optical Device Bay - 12.7 mm (h) for Optical CD/DVD Device Drive 
Options (see “Optional” on page B - 5)

Audio Inter Azalia Compliant Interface
3D Stereo Enhanced Sound System
Virtual 8-Channel Sound System
Compatible with Sound-Blaster PRO™
S/PDIF Digital Output (5.1 CH)

Built-In Microphone
4 * Built-In Speakers
Built-In Sub Woofer
Built-In Audio DJ Console for Music CD (MP3 
Format Compatible)

Keyboard & 
Pointing Device

Full Size Winkey Keyboard with Numeric 
Keypad

Built-In TouchPad (Scroll Functionality 
Included)

PCMCIA One Type II PCMCIA 3.3V/5V Socket

Feature Specification
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I/O Ports Four USB 2.0/1.1 Ports
Two Mini-IEEE1394a Ports
One S-Video-Out Jack for TV & HDTV Output
One Serial Port
One Parallel Port (LPT1) Supporting ECP/EPP
One Infrared Transceiver (IrDA 1.1/FIR/SIR/
ASKIR)
One DVI-Out Port
One PS/2 Port (Mouse/Keyboard)
One Headphone-Out Jack
One Microphone-In Jack

One S/PDIF Out Jack
One RJ-11 Jack (Modem)
One RJ-45 Jack (Local Area Network)
One DC-In Jack
One CATV-In Jack (Functions with Optional 
TV Tuner Module)
One S-Video-In Jack for Video Input 
(Functions with Optional TV Tuner Module)
One Line-In Jack for Audio Input (Functions 
with Optional TV Tuner Module)

Communication Infrared Transfer 1cm ~ 1M Operating 
Distance

115.2K bps SIR
4M bps FIR
IrDA 1.1 Compliant

10/100/1000 BASE-TX Fast Ethernet LAN on 
board
Integrated V.90/56K Azalia Modem (V.92 
Compliant)

802.11b/g Mini PCI Wireless LAN Module 
(Optional)

Bluetooth™ Class II V1.2 & 802.11b/g 
Wireless LAN Mini PCI interface Combo 
Module (Optional)

300K Pixel Video Camera Module (Optional)

Card Reader Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ MMC/ CF/ Micro Drive/ SM)

Feature Specification
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Indicators LED Indicators (System Activity, Suspend/Power On/AC-In, Battery Charging/Battery Full, Num 
Lock, Caps Lock, Scroll Lock, Card Reader)

Power 
Management

Supports ACPI 2.0
Supports Hibernate/Standby Modes
Supports Battery Low Sleep

Supports Resume from Alarm
Supports Resume from Modem Ring

Power Full Range AC Adapter - AC-In 100~240V, 47~63Hz, DC Output 20V, 9A
Easy Changeable 12-Cell Smart Lithium-Ion 6600mAH Main Battery

Environmental 
Spec

Temperature
Operating: 5°C ~ 35°C
Non-Operating: -20°C ~ 60°C

Relative Humidity
Operating: 20% ~ 80%
Non-Operating: 10% ~ 90%

Physical 
Dimensions & 
Weight

397mm (w) * 298mm (d) * 49.5mm (h) 5.80 kg with Battery

Optional Software DVD Player
DVD-ROM Drive Module
DVD/CD-RW Combo Drive Module
CD-RW Drive Module
DVD+RW Drive Module
DVD-RW Drive Module
DVD-Dual Drive Module
DVD Multi Drive Module

Mini PCI TV Tuner Module

Mini PCI 802.11 b/g Wireless LAN Module

Mini PCI 802.11b/g Wireless LAN + Bluetooth 
Combo Module

300K Pixel USB 2.0 Video Camera Module

Feature Specification
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